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Foreword 

There are a thousand ways to create an airport for Condor 2, we propose a safe and effective 
method, deduced from experimentation, with the Wings 3D modeler, based on the building of an 
airport which will be integrated in AA2 scenery, version 1.0. 
 
If you have never made airports and are interested to start building one or more particular airports 
that you know well, because you take-off from them, to perform, in real life, tasks in the countryside, 
this tutorial is for you. If you do not know anything about it, but want to help the Condor community, 
this tutorial will help you t build your first airport step by step. If you are already an expert in this 
matter, you will certainly find some good ideas to improve your expertise because we have tried to 
be as exhaustive as possible. 
 
For those who master another 3D modeler like, Blender or 3DS Max, for which it has been 
demonstrated that the conversion to "Wavefront" is reliable enough to create the c3d files of an 
airport, this tutorial will give them all the information needed to build an airport for Condor 2 with 
their favorite modeler. 
 
The choice of the airport was set on "LOKL Lienz-Nikolsdorf" for the AA2 scenery (UTM 32N) with 
the approval of Michel Bernard, alias DGTFER, who will take care of the integration and the tests and 
who took part in the correction of this tutorial. 

Tools 

Of course, you have to be connected to the Internet to access the various free software and airport 
data that you want to model. 
 
You must download the "Condor Landscape Toolkit" CLT 1 from the international forum, and deploy 
it on your computer, in a suitable folder whose name must not include any spaces or special 
characters (Ex: Condor2Tools): 
 
http://www.condorsoaring.com/downloads-2/ 
 
We will mainly use "Landscape Editor" and "Object Editor". 
 
and for modeling, we will use "Wings 3D" which is downloadable here: 
 
http://www.wings3d.com/?page_id=84 
 
There, we will choose the latest stable version. This tutorial was written using "Wings 3D 2.2.4". 
 
It also requires a 2D drawing software like "Photoshop" (since CS2 version), or "The Gimp", or 
"Paint.Net" so that you can apply textures or colors to the Textures maps. 
We used Photoshop CS6, but the other free choices are equally powerful, and allow you to perform 
all the required tasks. 
 

http://www.condorsoaring.com/downloads-2/
http://www.wings3d.com/?page_id=84
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Many free textures are on the Internet, just search for them. Use seamless textures or apply photos 
to the faces of airport hangars. But do not forget to quote your sources, or have them quote, in the 
scenery "Read me" file. 
 
Finally, an image capture software like "Capture Tool" from "Windows" or "Snagit" is also needed to 
save images and maps in order to insert them into the creation of the airport as support or texture. 
 
"Google Earth" is a basic source of documentation to build an airport, for Condor 2. 
 
Ultimately, the use of "Qgis 2.18.24" and "Qgis 3.6" may be necessary to adapt the maps to the UTM 
projection of the scenery where the airport will be inserted and also to access detailed information 
on the buildings, if they have already been registered in the database. 
The versions of Qgis can be downloaded here: 
 
https://www.qgis.org/en/site/ 
 
This manual does not include learning about these different software, if not generalities, except for 
beginners with Wings 3D. But each step of the construction will be sufficiently, detailed and, 
illustrated to allow you to accomplish the necessary tasks for the building of an airport. 

Goals and Prerequisites 

The goal of this tutorial is to build an airport detailed enough to allow airfield users to immediately 
recognize their airports, and to decorate it with small sketches with static objects (trees, gliders, 
devices, characters) in order to make it more alive. Once the airport is finished and integrated into 
the scenery, the only limit of the level of detail (LOD), is that a simulation in Condor 2 must remain 
fluid and without a jolt. The number of FPS that an average PC configuration of Intel I3 type with a 
GTX 750 Ti graphics card can support remains the basic criterion. In this case, in multiplayer mode, 
the number of FPS must imperatively be greater than 60 and preferably above 80. 
 
As the number of FPS also depends on the Forest Map, and because the detailed configuration of the 
forest areas around the airport is an important element of the visual recognition of the site, 
compromises will have to be made, despite the excellent graphics performance of Condor 2, with 
DirectX11. 
 
Here are the steps to be carried out, which will be detailed in the following chapters: 
 
1 / gather strong documentation with correct maps. 
2 / create the airport in Landscape Editor. 
3 / position the airport maps and scale them for Wings 3D. 
4 / create the surface elements of the airport, they are limited to these 4 objects integrated in 
Condor2: "Grass", "Asphalt", "Asphaltpaint" (Markings on the asphalt), "Grasspaint" (Markings on the 
grass), but that also allows you to integrate 3D objects, as edge markers in "Asphaltpaint". 
5 / create buildings, hangars, control tower, etc. of the airport. 
6 / export to Wavefront (.obj). 
7 / transform into C3d and bind the textures. 
8 / integrate the airport into the scenery with "Landscape Editor"  
9 / improvements. 
 

https://www.qgis.org/en/site/
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But before starting the building of the airport, it is necessary to have a succinct knowledge of: 
- Condor 2 soaring simulator folders, and those related to one scenery. 
- Objects in Condor2 
- Condor 2 airport operations and tow plane ballet. This will help you make the right compromises, 
especially for airports in narrow valleys. 
- Wings 3D with the creation of structured primitives, and keyboard shortcuts adapted to the building 
of airports. 

Condor 2 and scenery folders 

Here is an image from the Condor 2 folder tree:  
 

Figure 1 - Répertoire Condor 2/Condor 2 Folder. 

 
Two folders are concerned with the airports building: 
 
- The "World" folder: watch only and don't modify the "Objects" and "Textures" sub-folders. This 
"World" folder at the root of Condor2 should not be mistaken with the "World" folder in each 
scenery. 
 
- The "Landscapes" folder where are all the sceneries can be found. 
 
Each scenery has the same folder structure and the same files: 
 
Here is the folder of the WildAlps2 scenery under construction: 
 
 
 
 
 
 
 
 
 
 



Version 1.0 en - 2019-09-16  Page 9/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

Figure 2 - Répertoire d'une Scène/Scenery Folder. 

Figure 3 - Répertoire "Airports"/Airports Folder. 



Version 1.0 en - 2019-09-16  Page 10/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

Two folders and a file concern the creation of airports: 
- The "Airports" folder: 
 

* The 2 files LSGR_Reichenbach G and O opened in Object Editor. 
This airport is already integrated in the AA2 scenery, version 0.5. 

Figure 4 - Reichenbach : Fichier G/G File. 

"Object Editor" is a good way to control that objects and textures are properly linked when loading a 
C3D file from the scenery folder. 
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Figure 5 - Reichenbach : Fichier O/O File. 

 

 
Figure 6 - Reichenbach dans AA2/Reichenbach in AA2. 
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Reichenbach in AA2 and WildAlps2. It is exactly the same modeling for both airports. 
 

 
Figure 7 - Reichenbach dans WildAlps2/Reichenbach in WildAlps2. 

- In the "World" folder of the scenery, you will usually find two folders: 
* An "Objects" folder where all the current objects of the scenery can be found. 
* And a "Textures" folder where the textures of the current objects of the scenery can be found. 
 
This configuration and the naming of these folders are arbitrary, but it has become a Condor 2 
standard. Of course, they should not be mistaken with the "World" folder at the root of Condor 2. 
 
However, we can also put the textures of objects in a sub-folder of "Objects", in order to have 
relatively indexing, which simplifies the moving of objects from one scenery to another. It will no 
longer be necessary to correct the paths. However, it will be necessary to put textures that can 
replace the generic textures of Condor (forest textures) in a "Textures" folder located in the "World" 
folder of the scenery. 
 
All objects in C3D can be viewed and edited in Object Editor. It is then possible for each line to 
directly assign a texture to the object, linked with the corresponding UV Map. We can then choose 
the format (DDS, PNG, BMP, TGA) and the dimensions of the square texture of the object that we 
want, for example 1000 x 1000 pixels without being locked in the multiple dimensions of 2n that 
offers Wings 3D. 
 
This little tour in Condor2's folders shows you how to organize your work when you want to create 
an airport and test it in scenery, then share it: 
 

- Put the textures of the buildings of an airport in a folder whose name recalls the airport name, in 
the folder "Airports". 
 
- For common objects, create a folder "World" specific to the scenery and create two sub-folders 

* "Objects" for the objects files in "C3D" 
 
* "Textures" for the textures of these objects. 
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Or choose the formula "World/Objects/Textures" to put the textures of the object. 
 
"Object Editor" will allow you to quickly create paths to the textures of the object. See the "Texture" 
column in the example above. 
 
Finally, access to the file of the airports list (SceneryName.apt) is done simply in Landscape Editor, we 
will come back to it later, although utilities have been created for this purpose. 

Condor 2 Objects 

Objects of all kinds are built in a 3D modeler with appropriate textures, linked with the UV Map. They 
can be oriented and scaled for each instance of the object in Landscape Editor. All the current objects 
of a scene are in a database which corresponds to the file "Scenery_Nam.obj" of the Scenery. 
 
There are two types of objects that can be used with Condor 2 after exporting and converting to C3D 
formats: 
 
- The "Scene Object", it is a single object which can be made of multiple objects that have been 
combined into a single object in the 3D modeler. Finally, only one texture per Scene Object is 
accepted by Condor 2. This unique texture regroups all the UV maps of each previously combined 
object. It is often necessary to reorganize the isles of the UV Map so that they do not overlap on the 
final texture map. Texture maps can also include any semitransparent parts if you use "TGA","PNG" 
or "DDS" files. In "Object Editor", the C3d editor of Condor 2, there will be only one line. 

Figure 8 - Objet Standard /Scene Object. 

 
 
 
Here is a more complex Scene Object with transparent parts embedded in the texture: 
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Figure 9 - Objet Standard avec des Transparences/Scene Object with Transparencies.  

 
It's still a scene object with a single texture. 
 
- The Landscape Object is a collection of Scene or Landscape Objects that is exported into 
"Wavefront" format without combining the objects that compose it, into a single object. The number 
of textures of the Landscape Object is the sum of all the textures of the Scene Objects and of the 
Landscape Objects that compose it. In "Object Editor", the C3d object editor, there will be for a 
Landscape Object as many lines as textures necessary for its visualization, in the simulation. 
Landscape Objects allow you to regroup objects to form small scene. 
 
Landscape Objects act as a container for Scene Objects and/or Landscape Objects. In a Landscape 
Object, the positioning (coordinates and orientation) of objects is permanently set to make a little 
scene. It is then possible to manipulate these globally. 
 

Figure 10 - Objet de Scène/Landscape Object. 

 



Version 1.0 en - 2019-09-16  Page 15/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

 

Figure 11 - Image épinglée/Snaped Image. 

However, when creating a Scene Object in the modeler, when merging another Scene Object, care 
must be taken when orienting the included scene object that will have to be previously combined by 
a "Combine" and once oriented, divided by a "Separate". Partial recombination will probably have to 
be made in order not to fall in the way described below. 
 
A defect that we often see in Landscape Objects is the multiplication of calls to the same texture for 
different parts of the same object. These different parts, which we understand the necessity to 
multiply the same object in several recasts (subassemblies positioning) and in several liveries 
(textures) should, before their integration in scenery, be combined so that there is only one call for 
each texture. 
 
The two, G and O, files, of an airport are only special Landscape Objects, which meet the same 
criteria as a current Landscape Object. Except that we cannot adjust their scale in Landscape 
Editor. Hence the need to make a modeling as perfect as possible. 
 
There are many C3D free objects available on the Condor 2 forums. Some creators allow to use freely 
the objects they have created. But not all objects have this status. Do not resist to the fancy to create 
your own collection of objects, which you can eventually exchange with other objects or scenery 
creators. Open Object Editor, and have a look to all the World/Objects folders in each scenery and 
open the C3D files. You will find beautiful objects, well designed with a number of vertices as low as 
possible. You will also find other one, which aren't that nice. In the viewing window, with a L/G 
maintained, a left click maintained with the mouse, you can in moving the mouse change the position 
of the line of sight or if you prefer to rotate the object; and with a R/D maintained, a right click 
maintained, you can zoom in or out by moving the mouse. Examine all these objects carefully, to get 
an idea of what must be added to make your airport more alive, but ask the object designer, through 
the scenery creator, if you can use it freely. 
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Airport operation with Condor 2 

Condor 2 follows the same airport operation creation as Condor 1, with some variations. 
 
But the functional duality remains the same with: 
 
- Grouping the technical data relating to the airport in Landscape Editor: 

* the airport name called "AirportName", 
* the position of the center of the airport (latitude and longitude in decimal degrees and altitude 
in meters) which is nothing but a classic Turning Point, 
* the orientation of the runway in degrees, 
* The length and width of the runway defined in Landscape Editor are only used to adjust the tow 
plane ballet and the positioning of the glider's start place (see diagrams below). 
 

These data are created in Landscape Editor and all airports data are regrouped in the file 
"SceneryName.apt", and can be edited in Landscape Editor. The start place of the glider is in the axis 
of the runway with Condor 2, 200 m from the runway threshold. The latter options allow the airport 
adaptation to the immediate environment to set priorities in the orientation of the airport and the 
position of tow plane ballet, on the right or the left side, for a runway take-off direction. 
 
- Grouping the physical data, that is to say the visual aspect of the airport, in two files, coming from 
the modeling in a 3D modeler: 

* G file contains ground objects that do not cause crashes when a glider rolls on or run into them. 
The crash on a runway, during the simulation, is the result of the evaluation of the vertical 
acceleration of the glider when landing on the ground. 
 
The objects in this file are usually flat, two-dimensional (2D) in most cases, but you can also 
embed three-dimensional frangible markers or even any other object. 
 
This file of ground objects is named: 
 
"AirportNameG.c3d" 
 
The suffix "G" in the file name corresponds to "Ground", in English. 
 
Four types of flat, pre-defined objects are available in Condor 2. They have special seamless 
textures, and compose the usual airport grounded objects: 
- "Grass": to make the background grass of any airport 
- "Asphalt": to make hard runways, taxiways, car parks, floors of open hangars, etc. 
- "Grasspaint": to make the markings on the grass runway. 
- "Asphaltpaint" to make markings and frangible markers found on the hard runways and their 
annexes (taxiways, etc.). This texture can also be used on Grass. 
 
You can also change the white color of some of the markings painted on the runway, and the 
color and/or the texture of a part of the runway, or taxiways, using a particular designation for 
custom textures, built by the creator of airports. 
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* O file contains all other 3D objects that cause a crash when the glider collides with them. 
 
These 3D objects are either Scene Objects or Landscape Objects. They are grouped in a file 
named: 
 
"AirportNameO.c3d" 
 
The suffix "O" in the file name corresponds to "Objects", in English. 
 
This file will regroup the bunkers, the hangars, the control tower, the barracks, the significant 
buildings around the airport, the windsocks, the skid fuel stations, etc. 
If they do not result in excessive loading times at 24 km, static planes and gliders, whether or not 
forming small scenes, fences, characters, trees, glider trailers, cars, and devices, can be added to 
the O file, in order to make the modeled airport alive and realistic. 
 

It is from the complete airport modeling, created with Wings 3D that these two files will be 
exported to "Wavefront" format. After transformation into C3D format, they will be placed in the 
"Airports" folder of the scene, in order to be used by the simulation. 

 
The only common elements to these two technical and physical entities are: 

- The "AirportName" which must be identical in Landscape Editor and in the O and G files, 
- The airport center, defined in Landscape Editor from its coordinates (Longitude, Latitude and 
Altitude) corresponds to the center of the scene (with coordinates X = Y = Z = 0) in Wings 3D. 
- The runway direction along the X axis of Wings 3D. 

 
This duality wanted by the Condor designer is very effective because it allows for easy correcting of 
the position, altitude and orientation of the airport in the scenery. Indeed, all the sceneries are 
affected by construction, by material errors for example a few meters shifting between the heights 
map and the canvas of the Terragen tiles, or structural errors, as for example, the UTM Nord which is 
never true North except on the reference meridian, etc. 
 
This has two constraints: 

- Make the surface of the airports rigorously flat for everything concerning the G file. It will 
therefore be necessary in Landscape Editor (when the time comes) to flatten or set the whole 
area of the airport at the same altitude and save this new state of the heights map. Of course, this 
final altitude will also have to be corrected in the definition of the airport in Landscape Editor so 
that these two altitudes are identical. 
- The second constraint lies in the fact that there is only one main active runway, the runway in 
the X axis in Wings 3D. 

 
These two constraints can be partially overcome, with a little bit of imagination to adapt to 
differences in altitude in the positioning of hangars or other objects, but also to "altiports" that have 
unidirectional sloped runway and airports with multiple runways, making some concessions. 

Main Advices: 

When the glider reaches about 24/25 kilometers from an airport, airport files are loaded into the 
simulation. There is therefore a risk of lack of fluidity at this time if the airport is too detailed or if the 
textures are too big. 
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But it is only when the glider reaches about 5 km from an object not integrated in the O file of the 
airport that the files of the object is loaded in the simulation. This can be interesting because it 
allows the loading times of these objects to be diluted over time as the glider approaches the airport. 
 
It may be therefore interesting to separate the static objects common to several airports from the O 
file of the airport and to keep for the O file only airport-specific objects such as hangars, 
administrative buildings, workshops, fuel stations, control tower and windsocks. In principle, all 
objects that are static by destination have to be modeled first. 
 
In our opinion, you must always integrate the complementary airport objects (isolated trees, static 
gliders, various devices, runway pickups, glider trailers, cars, characters) once the airport is perfectly 
integrated into the scenery and only after the main tests have been performed, and that the loading 
time to 24 km is very low for an average PC configuration. Never put an object in the axis of the 
runway and avoid that they are collided by the tow plane while the tow plane is moving at the 
airport. 
 
Otherwise it is best to put all objects in the "World/Objects/" folder of the scenery and their 
corresponding textures in "World/Textures/" folder. This has the advantage, in addition to the spread 
loading times of these objects, to have only one C3d file per object that will not be duplicated for 
each airport in which it will be integrated. 

The Tow planes ballet 

Tow planes are special aircraft, since these flying objects do not cause any collision and pass through 
everything without damage: mountains, buildings, objects of all kinds, except that they can put the 
towed glider in delicate situations. 
 
We conducted several experiments in the absence of data provided by the software developer, not 
exhaustive, but sufficient to understand the trajectories of the tow planes around the airport, on the 
runway and in the air. 

Tow planes take-off towing a glider, in Condor 2: 

We used a Duo Discus with a maximum weight of 750 kg with two pilots and full ballasts towed 
through a 50 m rope, without wind or thermal activity, and the undercarriage remains lowered in all 
the experimentation. 
 
In these conditions, the tow plane will follow a fixed trajectory, in a plane perpendicular to the 
ground on the center line of the runway up to 100 m above the altitude of the airport (AGL). The 
distance traveled will be given by the integration of all the forces exerted on the entire glider and 
tow plane. The trajectory can be lengthened only by unwanted maneuvers of the glider pilot who 
creates excessive drag. 
 
For the setting of the airport options, 3 elements are interesting to know: 
- Distance SA traveled by the glider so that it reaches its take-off speed, the yellow index on the 
speedometer. 
- Distance SB traveled by the glider when the tow plane has taken off, with the disappearance of the 
dust raised by the wheels on a grass runway. 
- Distance SC traveled by the glider at the moment when the tow plane reaches the altitude of 100 m 
above the airport altitude (AGL, Above Ground Level), and where the tow plane will start its first 
turn, led by artificial intelligence. 



Version 1.0 en - 2019-09-16  Page 19/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

 
If the tow plane is too close to a mountain wall at point C and turns in the wrong direction, it will 
cross the mountain without any difficulty while drawing the glider into a probable crash if no evasive 
maneuver is made. 
Here is a schematic diagram that summarizes the situation: 

Figure 12 - Schéma du décollage/Take-off chart. 

And here are the results of the experiment in meters at ± 10 m: 
 

Tow plane SA SB SC 

DR400 190 390 1600 

Dynamic 260 450 1690 

Super Cub 370 670 2000 

Wilga 150 330 1450 

Z-226 250 390 1500 

 
By changing the length of the runway, in Landscape Editor, we will be able to adapt the operation of 
the airport to the imperatives of the topography, especially in mountains landscapes. 

Tow plane landing and taxiing on the airport towards its parking place. 

For a fixed configuration of airport width in Landscape Editor, the following factual elements can be 
easily ascertained, regardless of the type of tow plane: 
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- The touchdown of the tow plane wheels is on an extended line from the threshold of the runway 
defined in Landscape Editor, but always outside the runway delimited in Landscape Editor in two 
distinct impacts, spaced approximately 5 m, depending how the tow plane has made its downwind 
leg from left or right relative to the runway axis, named Al/g and Ar/d. 
 
- The tow plane runs about 350 m, and begins a turn. 
 
- After completing its 180 ° turn, the return axis is at a distance R from the runway centerline. 
 
- It then makes a 90 ° turn to come on the starting line of the glider at a distance St from the axis of 
the runway and always 200 m from the runway threshold defined in Landscape Editor. 
 
There is, therefore, only one main variable, the width of the runway in Landscape Editor and a 
secondary variable for the touchdown point. 
 
It should be added, as this can be seen when the glider is in the runway axis at take-off, that there is 
a desired variability around the true value of ± 2 m that we will find in all the results. 
 
Here is a schematic diagram that summarizes the situation: 

Figure 13 - Schéma du roulage/Landing Chart. 
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And here is the result of the experiment for few runway widths, in Landscape Editor: 
 

Runway Width in 
LE 

0 to 25 m 50 m 75 m 100 m 

Al/g|Ar/d 28|23 m 35|29 m 42|47 m 60|55 m 
R 69 m 75 86 98 m 

St 41 m 50 60 72 m 

 
The numeric values have a random variability of ± 2 m, as desired by the software developer. 
 
All these data must allow us to know where it will be imperative to flatten at the same altitude the 
heights in the topography. In multiplayer mode, where multiple tow planes may be provided, they all 
line up along a line parallel to the runway centerline at distance St, and extend to the tow plane 
return loop. 
 
All these data will also allow you to adapt the tow plane ballet to the uses of the runway by changing 
the width and the length of the runway in Landscape Editor. 
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Wings 3D :  

Basic operations 

A good-quality French interface is available although sometimes entire sections of the software or 
specific windows are not translated from English. The interface is also available in many other 
languages. This interface in French or in another language is accessible from the "Edit" menu by 
following the sequence with left clicks or by clicking on the gear icon on the Toolbar. 
 
"Edit -> Preferences -> Tab 'User Interface' -> Frame 'language' -> Click on the arrow of the pop-up 
window and click on 'Français' -> OK". 
To take full advantage of the language choice, you have to stop and restart Wings 3D. 
 
This will be useful to start and read the short chapters of Help menu or to test complex features. 
 
However, we will use in the following, the English version of the interface, which is universal and 
adapted to all windows of the software, but also allows you to disconnect from the emotional 
burden of words in French, or in your native language, to focus on the only functionality of the 
proposed actions. Or, as archaeologists repeat, we must "know how to get out of the universe 
associated with the word that is chosen". Nevertheless, we will propose each time an adapted 
translation in parentheses and vice versa for the French terms, except for the English version of this 
guide. It is also a good way to become familiar with the Anglo-Saxon terms used in 3D without 
necessarily being bilingual. 
 
All three-dimensional real-world objects can be decomposed into a 3D modeler in Vertices. These 
vertices are then connected to each other by more or less long straight lines or Edges, and a loop of 
Edges forms a Face not necessarily flat. The set of Faces connected by common Edges forms an 
Object. Objects are a closed set of faces, so it is impossible to unfold them without cuts or 
segmentation. A set of objects arranged and oriented in space forms a Scene. These are the 
fundamental elements that make a file of a Scene in a modeler like Wings 3D. 
 
It is from selections, on one of the 4 modes mentioned above - Vertices, Edges, Faces, Objects - on 
which we will apply transformations that the initial primitive will be metamorphosed into the object 
that we want to build. The whole art of building a 3D object lies in the ordered application of 
successive transformations to obtain the desired result. 
 
The particularity of Wings 3D is to define a 3 axis widget O [x, y, z] according to the Anglo-Saxon 
standards with a vertical axis Oy instead of the usual Oz axis of the Continent. Since it is not possible 
to redefine the name of the axes, you have to get used to it. For exports to other modelers or games, 
the option to replace the Oy axis with Oz exists: "Swap Y and Z Axes". There will be no particular 
difficulty if necessary. 
 
Here is a commented excerpt from the interface of version 2.2.4, which will allow you to start almost 
immediately, because you are constantly informed by the "Information Line" and the "Status Bar", 
about what you can make and on what the transformation will be applied. 
 
The most important keyboard shortcut is the deselection of all current selections by pressing the 
"space bar" key. It is noted by S/E in the following. 
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To load a primitive, after a total deselection with the space bar, S/E, an R/D, right click in an empty 
place of the "Geometry" window, brings up a pop-up menu in which you make your choice. 
 
Interface 2.2.4 
 

Figure 14 - Interface Wings 3D 2.2.4. 

For those using Wings 3D, for the first time, it is best to note the various processes used in this guide 
on a separate document that will serve as a summary. 

Conventions of the information line extended to the whole document: 

At the bottom of the window "Geometry" (2.XX), the letters L:, M:, R: (French menu: G, C, D) appear 
systematically in the "Information Line", after a selection and even when nothing is selected. These 
labels are followed by a short explanation that indicates you what you can do in the Wings 3D 
window, where the mouse cursor is positioned. 
 
These labels correspond for Wings 3D to: 
L ("Left" in English, for Gauche in French). To validate the option displayed after "L:", you must click 
with the left mouse button, where the mouse cursor is positioned. 
M ("Middle" in English, for Central in French). To validate the option displayed after "M:", you must 
click with the mouse wheel, where the mouse cursor is positioned. 
R ("Right" in English, for Droit in French). To validate the option displayed after "R:", you must click 
with the right mouse button, where the mouse cursor is positioned. 
 
After one of these 3 clicks on the mouse buttons, if an action is required, action is performed by 
dragging the mouse, except in special case, until the desired amplitude has been reached. The end of 
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the mouse drag ends with a left click, L/G if the action is accepted, or with a right click, R/D to return 
to the previous status. 
 
In some cases, it is also mentioned the left double click LL and whether it is necessary to keep the 
mouse button held down during the completion of the transformation is an L maintained. 
 
These mouse clicks are made on an empty space on the screen, on an object or an element of the 
object or on menu items or after a selection and after a call by a R/D of a pop-up window on an item. 
Each time, the information line will indicate a relevant procedure, when the mouse cursor hovers 
over an item or any window. 
 
Do not mistake the action of turning the wheel of the mouse "Scroll" with the central click. The wheel 
is only dedicated to moving the camera (zoom and pan). 
 
In the latest versions, "Info bubbles" tend to duplicate the information of the information line for a 
few seconds. 
 
In order not to mistake the clicks and the action on the wheel of the mouse with the keys of the 
keyboard, the following conventions are adopted in this document for all the software used: 
 
L/G, M/C and R/D, LL/GG, L/G maintained, R/D maintained and S/M will be the bilingual indications 
(Left/Gauche, etc.) of clicks to be performed with the mouse to validate the corresponding options. 
In the absence of an indication of the type of click to perform, it is an L/G that must be done to 
perform the action. The additional keys, Shift, Ctrl, and Alt with the mouse, are sometimes necessary 
to extend the possible actions. They will be noted: Shift+R/D, for example, to right-click with the 
SHIFT key pressed. 
 
The keys to be pressed will simply be named by their uppercase values, for example, V to switch to 
Vertice Mode, E to switch to Edge Mode, F to switch to Face Mode, O to switch to Object Mode, etc. 
All keyboard shortcuts will be written in the same way and the space bar by S/E. This will significantly 
lighten the sequences of techniques explained in the remaining of the text. The separation between 
2 actions will be noted by:" -> ". If the assignment of a right click, R/D, is not specified, the right click 
will always be executed in the window "Geometry" to call the contextual menu of the possible 
actions on a selection with the chosen Mode. If there is no assignment to start the action, a L/G must 
be done. 
 
Wherever you are in the construction of your object, you will never be alone! Just read the 
instructions from the "Information Line" to continue. 
 
It's extremely convenient and that's what makes learning Wings 3D so easy. 
 
With Condor 2, a Wings Unit (WU) is equal to 1 m. 
 
In addition, the decimal point is used to separate the integer part from the decimal part of a number 
instead of the comma (default decimal separator for French). 
 
For the remainder, practice, because it is by practice that we progress. 
 
For the construction of airports, we will guide you step by step with the conventions that we have 
just explained. It will also be an apprenticeship to Wings 3D. 



Version 1.0 en - 2019-09-16  Page 25/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

Primitives adapted to airports modeling 

To avoid having to repeat each time the same work, we will create some special primitives to gain 
efficiency. 
 
At the very least, you must build: 
 
- A 50 mx 50 m square, without thickness, 2 faces and 4 vertices, with "Hole" in the bottom face to 
optimize the FPS, called "EPiste" and which can be used for all objects "Grass" and "Asphalt" for the 
G. file. 
From this first primitive, all the elements "Grasspaint" and "Asphaltpaint", in conformity with Annexe 
A, of ICAO (Annexe 14, book I in English) will be created, as and when necessary. Finally, we will build 
a whole collection of ready-to-merge objects like numbers, arrows, etc. 
 
- A 15 x 8 x 7.5 m Hangar with a "hole" in the bottom face to optimize FPS. 
 
If necessary, we can also create a circle of 15 m diameter of zero thickness in 32 or 64 sections. 
 
There are at least 4 ways to create a square primitive without thickness from a 3D primitive 
 
- Starting from a cube and "Weld" one by one the vertices of one face to the opposite face. 
- Starting from a cube and "Extract" a face. 
- Starting from a cube select the five bottom faces -> R/D -> L/G on "Hole". 
- Choose the right options when defining the primitive. 

Creating the "EPiste" primitive 

Open Wings 3D, then dock or not the windows, "Geometry Graph" and "Outliner", to the right edge 
of the "Geometry" window. To do this, open these windows from the Menu: L/G on "Window" -> L/G 
on "Geometry Graph", then L/G on "Outliner". To move these windows, L/G on the title bar of each 
window, until the desired docking is viewed in purple, or use the Shift key to move them without 
docking them all over the "Geometry" window space and even outside, on another screen, for 
example. 
 
Perform the following sequences in this order: 
 
S/E -> R/D -> R/D on Cube -> Enter the values X = 50, Y = 0, Z = 50 and check "Put on the Ground" -> 
L/G on OK. 
 
For this first sequence of actions, here are the details of the operations: 
 
- S/E: deselect all, 
- R/D: a right click in the "Geometry" window brings up the primitives' window. 
- R/D on Cube: a right click on the "Cube" item in the primitive window opens the "Cube Options" 
window. 
- In this window, enter the values and check the box "Put on the Ground". 
- L/G on OK: a left click on OK closes the window "Cube Options", and ends the sequence. The 
primitive is displayed in the "Geometry" window with the chosen options. 
 
The notation adopted is much faster and below a diagram tells you what has been done. 
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Figure 15 - Création d'une primitive plate/Creating a flat primitive. 

At this point, you must get a flat square without dimensions, but this is not exactly what we want, 
because it is a rectangular parallelepiped of zero thickness with superfluous vertices and edges. 
 
Check your work from the Menu: 
"Tools -> Scene Info" 
 
which brings up the "Scene Info" window which lists all 
the objects of the scene: 
 
 
To end this new primitive, you must: 
 
- Clean the geometry to eliminate superfluous vertices, 
edges and faces with no dimensions. 
- Make Hard Edges so that there is no interference when 
applying the Smoothing Shader, which can create 
unwanted artifacts in Condor 2. 
- Remove the bottom. 
- Change the name "Cube1". 
- Perform a standard "UV Mapping" to obtain a "UV 
Map" and then a versatile "Texture Map". 
- Save the primitive under an appropriate name in a 
specific folder. 
 
Throughout these processes, the information line (at the bottom of the "Geometry" window) will 
guide you. 

Figure 16 - Scene Info. 
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1 - Geometry cleaning: 

Select your object with an L/G and switch to Object mode (Type O or L/G on the full icon on the 
right). 
R/D in the window brings up the pop-up window of transformations in Object mode 
L/G on "Cleanup". 
The Status Bar at the top changes and tells you that the "Cube1" selection includes: 
2 polygons, 4 Edges and 4 Vertices. That's what we want. 

2 - Edges must be "Hard": 

Select your object with an L/G and switch to Object mode (Type O or L/G on the full icon on the 
right). Then change to Edge Mode. 
R/D in the window display the window of transformations in Edge mode 
L/G on "Hardness" -> L/G on "Hard". 
The Edges become yellow. 

3 - Eliminate the bottom face 

Change the position of the camera: M/C, then, move the mouse to get a view of the bottom face, 
confirmation of the new position by an L/G or cancellation by an R/D. Practical and intuitive. 
 
S/E. 
Switch to Face Mode (press F or L/G on the 3rd icon). 
Select the bottom face with an L/G on that side. 
An R/D in the window displays the transformation window in Face mode.  
L/G on "Hole". 
Deselect all by S/E and check that the bottom side is missing by an L/G that can only select the front 
face, switch the camera to check the selection and read the Status Bar. 

4 - Change Name 

R/D on "Cube1" in the "Geometry Graph" window, then L/G on "Rename" or F2. 
In the "Rename" window, type an appropriate name, for example "EPiste" for Runway Element. 

5 - Standard "UV Mapping" 

In 80% of the cases a standard "UV mapping" will be enough to obtain a UV Map, with a quite 
definite pattern and a Texture Map usable if we choose the right options. 
 
Switch to "Object" mode and select "EPiste". 
 
R/D in the "Geometry" window, then L/G on "UV Mapping" (or R/D if you want to restart the "UV 
Mapping" from the beginning). 
An "AutoUV Segmenting: EPiste" window is displayed. 
In this window, R/D, then, L/G on the option "Segment by" and L/G on "Projection". 
The face changes color. 
New R/D in the "UV Segmenting" window, then L/G on "Continue" option, then L/G on "Projection 
Normal" (Projection along the Normal of each face). 
The "AutoUV Segmenting: EPiste" window disappears and is replaced by the "AutoUV: EPiste" 
window. This is the UV Map in which the face of our square which occupies the whole surface of the 
map on a checkered lettered background is selected. 



Version 1.0 en - 2019-09-16  Page 28/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

In the "Outliner" window, a new material appeared under the name "Episte_auv" which is associated 
a standard image "auvBG" (BG for "Back Ground"). 
 
Then, you only have to change the UV Map into a Texture Map with the correct options. 
 
Keep everything selected; if necessary, switch to "Object" mode, then draw a selection rectangle 
encompassing the entire UV Map with an L/G maintained. 
R/D in the "AutoUV: EPiste" window, to display the options, then, L/G on "Create Texture". 
A "Draw Options" dialog box opens. 
The square texture map has always a pixel size that must be defined: choose 512x512 pixels. 
Then, when creating the Texture Map, a series of passes in the "Render" frame are executed in the 
order displayed from top to bottom, the next pass covering the previous pass. The stacking of the 
passes is therefore on the texture from bottom to top. 
But for now put all the options on "None" - no drawing requested on the Texture Map of "EPiste". 
 

 
Figure 17 - Options de Dessin de "EPiste"/"EPiste" Draw Options. 

L/G on OK to transform the UV Map, in a Texture Map. 
 
It is better, but it is not mandatory to change the name of the material and the texture in "EPiste" 
and thus eliminate "_auv" 
To achieve this task, L/G on the Material "Episte_auv" in the window "Outliner", then F2 to access 
directly the window "Rename". Repeat the same sequence with the image "EPiste_auv". Close the 
"AuoUV: EPiste" window with an L/G on the cross at the top right. 
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6 - Creating a primitives folder for airports and Saving the primitive Episte. 

Starting from the Menu: 
"File -> Save", a dialog box opens and allows you to create a "New Folder" which is named 
"Aeroprimitive" and we have saved this primitive under the name "EPiste". 
 
That's all, for this first primitive dedicated to build airports, and important bases of Wings 3D have 
been explained step by step. Subsequently, we will be less verbose and we will only indicate the 
building sequences according to the conventions that we fixed. 

Creating the Hangar primitive  

"File -> New" allows to begin a new object. 
R/D displays the primitives. R/D on Cube displays the "Cube Options" window. Enter the size of the 
cube and check "Put on Ground". 
 

Figure 18 - Création de la primitive Hangar/Creating hangar primitive. 

L/G on OK to finalize the operation. 
 
It only remains to make the "Hard Edges", eliminate by a "Hole" the bottom face and give a proper 
name to "Cube1", in the "Geometry Graph" window before saving the file. 
These techniques were seen in detail during the creation of the primitive "EPiste", we will not make 
the same explanations. It is not necessary to do a "UV mapping". 
The name is "HLn" for Hangar Lienz-Nikolsdorf. It will be necessary to adopt a name corresponding to 
the airport that you will model. For each hangar created, you will add the suffix 01, 02, 03, etc., to 
identify without error all the hangars that you will have to create, on the many airports that you will 
create. 
 
Here is the final result: 
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Figure 19 - Primitive Hangar. 

Save this new primitive in the folder "Aeroprimitive" under the name Hn or any other name at your 
convenience. 

Shortcuts adapted to the creation of airports 

The list of all keyboard shortcuts can be found in the help section of the menu: 
"Help -> Defined Hotkeys". 
 
How to create a keyboard shortcut is explained here: 
"Help -> How To Define Hotkeys". 
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Figure 20 - Comment Définir un Raccourci clavier/How to Define a Hotkey. 

 
Sometimes CTRL+Insert or CTRL+8 and CTRL+Delete or CTRL+9 does not always work properly if your 
keyboard is a little old. It is often necessary to repeat the action and swap the initialization 
commands until the following statement is displayed to the information line: 
"Select a menu item to bind/unbind a hotkey". 
 
When building an airport, especially with the Runway Elements, it will mainly be necessary to move 
Vertices to a precise position on the ground of the airport, and even to superpose Vertices absolutely 
between "Asphalt" and "Grass" elements. These sequences are very often repetitive and sometimes 
boring. 
 
The only unaffected and practical keys are: 
 
H: This key will be assigned to horizontal movement to X on a selection of vertices. 
N: This key will be assigned to move to Z (Vertical or North/South) on a selection of vertices. 
K: This key will be assigned to the welding of 2 vertices linked by an edge. 
J: This key will be assigned to the superposition of two vertices. This keyboard shortcut avoids 3 clicks 
with the mouse. 

Creating the H Hotkey 

In Wings 3D, open a Cube primitive and select a vertex. 
Press "CTRL+8" or "CTRL+Insert" to initialize the process of saving the keyboard shortcut. 
The information line display "Select a menu item to bind/unbind a hotkey". 
R/D to display the menu of vertex transformations. 
L/G on "Move". 
L/G on X. 
The information line then asks you to choose the keyboard shortcut: 
"Press the key to bind "XXX" command to". 
Press the H key. 
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Creating the N Hotkey 

In Wings 3D, open a Cube primitive and select a vertex. 
Press "CTRL+8" or "CTRL+Insert" to initialize the process of saving the keyboard shortcut. 
The information line display "Select a menu item to bind/unbind a hotkey". 
R/D to display the menu of vertex transformations. 
L/G on "Move". 
L/G on Z. 
The information line then asks you to choose the keyboard shortcut: 
"Press the key to bind "XXX" command to". 
Press the H key. 
 
Now these 2 Hotkeys are displayed in front of the corresponding commands on the "Move"menu.

 
Figure 21 - Affichage des nouveaux raccourcis clavier/New Hotkeys display. 

 
Using the H and N Hotkeys 
Select vertices, press H or N, the vertices are highlighted and move the mouse to move the vertices 
horizontally (X) or northward (Z) planar to Y. H and N can be pressed one after the other in the same 
movement, without having to fix the position by an L/G. Fix the displacement by an L/G, return to the 
previous state by an R/D. 

Creating the K Hotkey 

In Wings 3D, open a Cube primitive and select a vertex. 
Press "CTRL+8" or "CTRL+Insert" to initialize the process of saving the keyboard shortcut. 
The information line should display "Select a menu item to bind/unbind a hotkey" 
R/D to display the menu of vertex transformations. 
L/G on "Weld". 
The information line asks you to choose the keyboard shortcut: 
"Press the key to bind "XXX" command to". 
Press the K key. 
 
Using the K Hotkey: 
Select a Vertex 
Press K, the Vertex is highlighted. 
R/D on the vertex on which the first vertex must be welded, the 2 vertices must be connected by an 
Edge. There is only one Vertex left. The moved Vertex is welded and eliminated. 

Creating the J Hotkey 

In Wings 3D, open a Cube primitive and select a vertex. 
Press "CTRL+8" or "CTRL+Insert" to initialize the process of saving the keyboard shortcut. 
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The information line should display "Select a menu item to bind/unbind a hotkey" 
R/D to display the menu of Vertex transformations. 
L/G on "Absolute Commands". 
L/G on "Snap" submenu. 
M/C to make the right choice. 
The information line asks you to choose the keyboard shortcut: 
"Press the key to bind "XXX" command to". 
Press the J key. 
 
Using the J Hotkey: 
Select a Vertex 
Press J, the Vertex is highlighted. 
R/D on another vertex of the cube or a vertex of another object on which the first vertex must be 
moved, the 2 Vertices would have exactly the same coordinates X, Y, Z. 

Last Resort: 

Sometimes Wings 3D version 2.XX does not support the implementation of complex keyboard 
shortcuts such as the J key. Fortunately, version 1.5.4 supports this type of keyboard shortcut very 
well and as keyboard shortcuts are common to all versions, J, created with Wings 3D 1.5.4 will be 
usable with all versions 2.XX so 2.2.4. It is even possible then to define a second keyboard shortcut 
having the same functionality as J for a selection of vertices. 
All versions of Wings 3D are compatible with each other. 
 
Here is the complete process for J 
Download version 1.5.4 on the Wings 3D website if it has not already been done. 
Go to the downloads page. 
At the bottom of this page is access to old versions "Old releases". 
L/G on "All release". 
 
A loading page at SOURCEFORGE opens, it is necessary to accept Cookies. 
L/G on 1.5.4. 
A new page opens with all versions of 1.5.4. 
Choose the version that suits you (Mac, Linux, or Windows 32 or 64 bits). 
Download and install this version. 
Make sure you have closed Wings 3D 2.2.4. 
Open Wings 3D 1.5.4. It works almost identically to version 2.2.4. only the appearance changes and 
the windows are trapped in the main window of the application. 
Through an R/D in the window "Geometry" access the primitives and load a cube and display help on 
how to set keyboard shortcuts by "Help -> How to define Hotkeys". 
Select a Vertex. 
R/D displays the Vertex transformation menu. 
L/G on "Absolute Command". 
In the submenu position the cursor on ".Snap", this one is highlighted. 
Press the "Insert" key and keep the cursor on ".Snap". 
The information line allows you to choose 3 different orders. Choose the central command by an 
M/C. 
Then press J. 
Close Wings 3D 1.5.4 and open Wings 3D 2.2.4 again. 
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List of defined Hotkeys 

For information, all the keyboard shortcuts added are at the end of the list of: 
 
"Help -> Defined Hotkeys" 
 

Figure 22 - Les nouveaux Raccourcis clavier dans la liste des Raccourcis clavier/New Hotkeys in the Defined Hotkeys List. 

 
Which indicates well, even in the absence of J in front of the command "Snap", that they are all 
supported by the last version 2.2.4. This list is common for all versions of Wings 3D on the same 
computer. 
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Modeling LOKL Lienz-Nikolsdorf Airport 

First, we must organize and create a specific folder for the creation of an airport, for example "Lienz" 
for the airport and a sub-folder, "doc" for photos and maps, in a hard-drive partition different of 
Condor2. A copy of the 2 primitives created for airports would also be welcome. Other folders in 
"Lienz" will be added later. 

1 / Gather strong documentation with UTM projection plans. 

This is an important phase of the process: it consists in collecting information for the building, the 
runways and hangars and their cladding, in order to model and texture them. 

Photos 

In the best case, you live near the airport and you are a member of the Gliding Club. 
In this case, shoot dozens of photos with your smartphone or a digital camera. There will rarely be 
too many. 
Start with general aerial views to locate all taxiways, parking areas, buildings, hangars, and various 
markings. 
Next, photograph each element individually with, if possible, a scaled object. 
For a building, in addition to a general perspective view of the building from the ground, try to make 
4 pictures, one per face, standing in the axis of the face, the farthest possible using only the 
maximum optical zoom to avoid distortions. These photos can be easily straightened in Photoshop 
and can be easily snapped as texture on each side of the building. 
 
Having a glider colleague who can do this work can help but it could be less convenient. You can also 
contact the Condor community. Success is not guaranteed! 
 
But in 80% of cases, you will get only scattered photos, and it will be just sufficient. 
 
However, a number of possibilities must be explored and images must be captured as and when they 
are found with appropriate capture software: 
 
Google Earth: 
- Around the airport, you will find some photos that you can possibly exploit. 
- If the buildings are in the 3D Google Earth database, you will have a fairly good overview and you 
will be able to look at the airport buildings from every angle, be patient and capture interesting 
views. 
- And if you can operate "Street View", near the airport, some details may be revealed. 
 
Internet: 
Of course, you also have to look for photos on the Internet, but also watch videos on You Tube or 
Dailymotion. Videos on approaches and landings will help you to understand details that may 
otherwise have escaped to your attention, such as buildings close to the runway, but not included in 
the airport area and it might be interesting to add them to the O file. 
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For Lienz-Nikolsdorf 
 
We just did a Google search by typing 
 
"Lienz-Nikolsdorf Airport" 

Figure 23 - Recherche de documents sur Internet/Searching documents on the Internet. 

 
It is obviously necessary to sort out between the subjects and the other flight simulators, but you 
have access to interesting information! 
 
All this ended with a collection of photos that will be used when the time comes to model and 
textures airport buildings. 
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Figure 24 - Liste des documents/Documents List. 

Note: Photos 1 to 13 are coming from the Lienz-Nikolsdorf airport modeled in Xplane. 
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Maps and Drawings 

In AA2, the patch where Lienz-Nikolsdorf is located bears the number t4570 of which here is the 
copy. It has a dimension of 2048 x 2048 pixels, which is the Condor 2 standard. 
 

 
Figure 25 - Tuilette t4570/Patch t4570. 

The airport is at the bottom left of the patch, an enlargement can be seen below. 
 
Although this map is in UTM 32 N, the projection of AA2, aliasing is important which gives inaccuracy 
in the positioning of the various elements of the airport, but allows to appreciate the various areas 
related to the photo texture in AA2 and that will have to be modeled. 
 
You will encounter the same difficulties with a synthetic texture with embedded OSM data. 
 
We must find more detailed maps and drawings! 
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Figure 26 - Lienz-Nikolsdorf de/from t4570. 

There are several solutions that we will explore. 

A Google Earth satellite photo 

 
Figure 27 - Lienz-Nikolsdorf de/from GE. 
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The photo is sharper and the resolution of the photos can be better than that displayed in standard 
value, but the reference is quite the ellipsoid WGS 84. You can notice that there are slight differences 
between these photos and the patch, on concrete surfaces. 
 
However, for these magnitudes of the order of one kilometer, the superimposition of the two images 
of Lienz-Nikolsdorf airport, one of Google Earth and the other of the t4570 patch, the distortion is 
tiny as shown by this photomontage: 
 

 
Figure 28 - Photomontage GE/t4570. 

Without an obvious error, it is therefore possible to use a Google Earth image directly to build the 
Lienz-Nikolsdorf airport. 
 
However, this may be an issue due to distortion for large sceneries, oriented East West, like AA2 and 
when the airport is positioned far away from the reference meridian of the UTM zone. 
 
To illustrate our subject in a rather simple way, here is Europe in UTM 32 and in WGS 84. 
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The choice of modeling an airport starting from a Google Earth image or modeling from a UTM image 
could arise for the airports far away from the reference meridian. 
It will be up to you to manage this difficulty. You can change the projection of the Google Earth 
photos in the UTM zone of the scenery with QGis. 
Lienz-Nikolsdorf longitude is 12.87 °, exceeding by almost 1 ° the UTM zone 32 for a reference 
meridian at 9°. 
 
Save the Lienz-Nikolsdorf image in Google Earth at the maximum resolution, start with a precise 
framing with a margin, press R to straighten the image. Repeat these two operations if necessary. 
Then by CTRL+Alt+S, save the image and choose in the drop-down window the maximum quality. L/G 
on "Save Image". Give a name, for example: "LienzGEMax" then L/G on "Save". 

Qgis 2.18 Las Palmas 

To avoid any unpleasant surprises, we will recover the elements of the airport and its environment in 
OpenStreetMap and project them in UTM 32. 

- Open Qgis 2.18. 
- "Project -> New Project". 
- "Vector -> OpenStreetMap -> Download OSM Data". 
In the download window, switch to manual and enter 
the zone encompassing the airport extensively in 
decimal degrees. You must give a name and a 
location to the output file, with a L/G on "Broswe". 
Then L/G on OK. After a few seconds, the download 

Figure 31 - Téléchargement de données OSM/Download OSM 
data. 

Figure 30 - Ajout d'une Couche Vecteur/Adding a Vector Layer. 

Figure 29 - l'Europe en projection UTM 32 et WGS84. 
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starts and you have the indication at the bottom left of the amount of data downloaded. 
Press "Close" and not "OK" to exit the download window. 
"Layer -> Add Layer -> Add Vector Layer" 
L/G on "Browse" to indicate the location of the OSM file that has just been downloaded. 
In the next window, choose "Lines" & "Multipolygons" or more easily "Select All", then OK. 

 
Usually, a map should be displayed in the main 
window. If this is not the case, continue, nothing is 
lost. 
 
L/G on ESPG4326 at the bottom right and the 
"Project Property | CRS" window opens. 
Check: "Enable re-projection on the fly on CRS 
(OTV)". 
And look for and select WGS 84/UTM area 32N, the 
certified ID is this: EPSG: 32632, the CRS corresponding to the scenery where the airport is located. 
L/G on OK. 
Now, the project CRS is "EPSG: 32632 (OTV)". 
 
In the frame, layer, R/D on the 
layer "Multipolygons" -> L/G on 
"Filter". 
 
The query builder opens. 
 
In the frame "Fields", L/G on 
"buildings" then L/G on "All" in the 
frame "Value", will show all the 
values of the field "building". 
 
Creating the filter expression: 
 
LL/GG on "building". The 
"building" field is loaded into the 
filtering frame. 
L/G on the "=" button in the 
"Operators" frame. The operator 
"=" is loaded the filter frame after 
"building". 
LL/GG on "yes" in the "Values" 
frame 

Figure 32 - Sélection des couches vecteurs/Vector Layers Selection. 

Figure 33 - Choix d'un SCR/CRS Choice. 

Figure 34 - Construction d'une Requête/Making a Request. 
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The query is finished, it appears in the filtering expression: 
"Building" = 'yes'. 
By adding the "OR" operator and repeating the entire previous sequence, you can add other filter 
values such as "hangar" or "cabin". 

L/G on "Test" (100 lines were found). 
L/G OK to close the information window. 
L/G on OK. 
 
R/D on the layer "Multipolygons" as filtered. Choose 
"Save As". 
 
The "Save Vector Layer As .." window opens: 
- Choose a format. 
- Choose a location and a name for the layer file. 
- Modify the CRS for that of the project 
- L/G on OK. 
 
Confirm the project CRS in the window 
"Reference coordinate system selector": L/G on 
WGS/UTM 32, 
Then L/G on OK. 
A new line appears in the layers frame named 
"Building Entities Polygons" highlighted. 
"View -> Zoom on Layer" display the map, if the 
main window was empty. 
 
To complete this operation: 
R/D on "multipolygons" -> L/G on "Filter". 

The query builder appears again. 
L/G on "Clear", L/G on "OK". 
All data in the "multipolygon" layer is then accessible again. 
 
By applying several filters on the "multipolygon" and "lines" layers, following the procedure 
described above, we obtain the following result for the airport map: 
 
- Outline of the airport area. 
- All the buildings of the airport. 
- The runway (its label 630 x 30 m) a black line of 2 pixels. 
- The car parks. 
- Taxiways and roads were left in the form of lines. 
 
The IDs of each building have been consulted, the heights of the buildings are not indicated. 
 
 
 
 
 
 
 
 
 
 

Figure 35 - Enregistrement d'une couche vectorielle/Vector Layer 
Saving. 
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Figure 36 - Plan OSM de Lienz-Nikolsdorf UTM 32 N/Lienz-Nikolsdorf OSM Map UTM 32N. 

QGIS 3.6 

If this sounds too complicated, with Qgis 
3.6 you can extract a standard map from 
the airport quite easily: 
 
Open Qgis 3.6: 
"File -> New Project". In the "Browser". 
L/G on "XYZ Tiles". LL/GG on 
OpenStreetMap. Zoom in on the airport. 
Change the CRS for UTM 32. L/G on EPSG: 
3852 
In "Project Properties": 
Look for the CRS UTM 32N. L/G on 
Minna/UTM zone 32N, L/G on OK. 
 
The CRS at the bottom right becomes: 
EPSG 26332. 
 
The vector map is now projected in UTM 
32 N. 
 
 
 
 
 
 

Figure 37 - Propriétés du Projet, SCR/Project Properties, CRS. 
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Figure 38 - Lienz-Nikolsdorf de/from Qgis 3.6, OSM, UTM 32N. 

It's a little less precise, but more than enough. Make a screenshot of the Airport in QGis 3.6. 
 
Now we have the following capture for Lienz-Nikolsdorf airport as drawings or maps: 
 
- A photo from the patch t4570 in UTM32. 
- A Google Earth photo in WGS 84. 
- A detailed map extracts from OSM data with Qgis 2.8 or Qgis 3.6 in UTM32. 
 
Although the projection or reference systems are different, remember that these maps or photos 
represent different and successive states of the airport Lienz-Nikolsdorf. As we must relate to the tile 
of AA2, it is ultimately on this one that the 
modeling will be based. 
 
These 3 maps can be loaded and scaled in Wings 3D 
to begin modeling the airport. 

Runway Official Data 

It is also necessary to consult ICAO tables on the 
airport that will be modeled. 
 
here is an excerpt from: 
 
https://www.openaip.net/ 
 
Displaying the official characteristics of the airport 
Lienz-Nikolsdorf. 

Figure 39 - Lienz-Nikolsdorf - Données/Data. 

https://www.openaip.net/
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2/ Creating Airports in Landscape Editor. 

How Landscape Editor works for airports 

Figure 40 - Reichenbach dans/in Landscape Editor. 

 
In Landscape Editor: 
 
Load scenery: open the drop-down list and make an L/G on the chosen scenery. 
 
With the "Hand" tool: 
Move in the map with an L/G maintained while moving the mouse. 
Zoom in with an L/G. 
Zoom out with an R/D. 
 
Any changes made in Landscape Editor will be lost if no backup is performed.  
Save by: 
"File -> Save Landscape", and wait for the end message and acknowledge with an L/G. 
 
The list of airports is visible only when "Airports" is highlighted. 
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An R/D on an airport display a contextual menu allowing to: 
 

 
Figure 41 - Menu Contextuel des Aéroports/Airports Pop Up Menu. 

The 1.33 zoom level provides access to high-definition textures, and the display of summary altimetry 
data. The zoom level of 10.67 displays all the elevation data with a mesh size of 30 m. With 
Landscape Editor for Condor 2, altimetry is displayed at or near the mesh vertex, making altitude 
change much easier to do. 
 
We can recommend adding a patch to Landscape Editor allowing you to use the 4 GB of your 
computer's memory in 32 bits. 
 
https://ntcore.com/?page_id=371 
 
But it will be insufficient to load the black and white textures of AA2 

Creating a new airport in Landscape Editor 

Although Lienz-Nikolsdorf Airport is already integrated in AA2 0.5, we will re-examine each property 
of an airport. 
 

 
Figure 42 - Ajout d'un aéroport/Adding an Airport. 

To create a new airport, R/D in the airport list window, an R/D displays a pop-up menu and an L/G on 
"Add" display a blank "Airport properties" window. When initially creating a new airport, use ICAO 
data or standard defined data. 

https://ntcore.com/?page_id=371
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1 - Name: Give a name to the airport otherwise it will be "New". This item should never be left blank, 
as finding a non-listed airport at the end of the list is not obvious and can lead to errors when loading 
the scenery. 
In addition, to avoid compatibility problems with other alphabets, here are the typographical rules 
that must be respected: 
- The name of the airport must not have accented characters, spaces or special characters, although 
these are most often accepted. 
- You must replace the "spaces" with underscores "_" or hyphens "-" or delete them. 
- To avoid any worries, it is necessary to be confined to the following characters: 
{a, b, c, ...., z} and {A, B, C, ...., Z} {0,1,2,3 ..., 9} and {-, _} 
 
2 - LON/LAT (Longitude /Latitude): Enter the coordinates, Longitude and Latitude, of the airport in 
decimal degrees. 
The precision of 6 digits after the decimal point is illusory. Rounding will be done automatically by 
Landscape Editor on a canvas that will be examined during the final tuning of the airport. 
 
3 - Altitude: Enter the altitude of the airport in meters. The accuracy is ± 1 m. Decimal values are not 
accepted. When finalizing, check that it corresponds to the final value chosen and used to flatten the 
airport area. 
 
4 - Direction: Enter the direction in degrees. The accuracy is ± 1 degree. Decimal values are not 
accepted. This precision is sometimes insufficient for satellite photo scenery or with synthetic 
textures including embedded data from OpenStreetMap, when the runway length in the G file is 
great. This accuracy will be improved in the future. 
 
5 - Length: Enter the length of the runway in meters. The accuracy is ± 1 m. Decimal values are not 
accepted. The length of the runway in Landscape Editor manages the departure glider positioning 
and tow plane ballet as shown in the chapter "Condor 2 and Airports Operation". Minimal standard 
Length is 400 m. 
 
6 - Width: Enter the width of the runway in meters. The accuracy is ± 1 m. Decimal values are not 
accepted. The width of the runway in Landscape Editor manages the tow plane ballet as shown in the 
chapter "Condor 2 and Airports Operation". Minimal standard Width is 25 m. 
 
7 - Asphalt: Check the box if the glider take-off runway is not grass. This changes the friction 
coefficient when the glider is rolling and there is no dust lifted behind the wheels of the tow plane 
when it is rolling on this type of surface. 
 
8 - Frequency (radio frequency): This is the radio frequency of the airport. It defaults to 123.50. This 
automatically sets the radio frequency for tasks starting from this airport. 
 
9 - The 3 checkboxes of the airport setting: When you create your airport, the positive X-axis in 
Wings 3D will give the direction of the runway with no wind, according to the direction written 
above, and will regulate the tow plane ballet that will put the tow plane to the right of the glider at 
the time of the starting of the towing sequence. To overcome the difficulties encountered with some 
airports you have the following 3 checkboxes, without changing the airport layout from the G and O 
files: 

Primary reversed: Check this box if you wish for technical or topographical reasons to change 
the glider's take-off axis with no wind. 
Tow primary dir left side: Check this box to place the tow plane to the left of the glider when 
no wind take-off axis is used. 
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Tow secondary dir left side: Check this box to place the tow plane to the left of the glider 
when the reverse take-off axis is used. This depends on the direction and the intensity of the 
wind relative to the main direction of the runway. 

 
L/G OK to finalize the creation of the airport and save the scene to save it permanently by: 
"File -> Save Landscape". 

3/ Load, Scale and Place Maps and Drawings in Wings 3D. 

Before opening Wings 3D, and loading the maps, it will be necessary to choose a standard reference 
dimension for scaling the selected maps. To minimize errors, use the longest length available, with 
the maximum of contrast. Asphalt or concrete runways are preferred. The length of the runway is 
suitable in most cases. But between what has been written according to the ICAO data in Landscape 
Editor and the reality, there may be differences. Indeed, the runway length does not generally take 
into account the runway extensions, and the concrete runway width is not necessarily the width 
retained in the official dimensions of the runway. 
 
To state upon this subject, we will use "Google Earth" and the tool "Rule" for the airport Lienz-
Nikolsdorf, to check and finalize the dimensions of our "Etalon" for scaling maps. 
 
For the length of the runways, we can evaluate with the rule the length of the runway at 623 m for 
the concrete runway; very close to the 620 m announced. The yellow lines in the following Figures. 
 

 
Figure 43 - Mesure de la Longueur de Piste/Runway Lenght Measurement. 
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Figure 44 - Mesure de la Largeur de Piste/Runway Width Measurement. 

For the width of the runway, the 30 meters announced correspond to the markings ends of 
beginning and end of the runway in white with hooks and with side markings very erased. There are 
also 3D markers at the threshold of the usable grass runway. The asphalt runway has a width of 
12.30 m. We will retain the values 623 x 12.30 m for our scaling "Etalon", and this "Etalon" will also 
be used to make the concrete runway. 

Creating the Standard Reference for Scaling 

Open Wings 3D 
 
Let's organize a little! 
Create a folder in "Geometry graph" by an R/D in this window and an L/G on "Create Folder" and 
name this new folder: "Images". 
Switch to "Orthographic" projection mode for the entire airport creation: L/G on the 3rd Icon of the 
group placed on the right side. 
 
"File -> Merge ..." 
 
In the dialog box, select "EPiste" with an L/G that is in the "Aeroprimitive" folder. 
Check in the options that the radio button is set to "All". Then L/G on OK. 
Migrate this object to the "Images" folder: L/G on the object, L/G on the "Object" icon, R/D on the 
"Image" folder and L/G on "Move to Folder". 
 
Sequence: 
- S/E: Space bar to deselect everything. 
- Switch to Edge Mode and L/G on a lateral edge parallel to X Axis. 
- R/D on the "Geometry" window -> L/G on "Absolute Commands" then L/G on "Move". 
- In the "Absolute move Options" dialog box in Z, type "6.15" (12.30 /2 m). 
- L/G OK. 
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Figure 45 - Création de l'Étalon/Creating the runway scaling element. 

 
Repeat the sequence for the opposite side and type Z = -6.15. 
Repeat the sequence twice to calibrate the runway lengths with X = ± 311.5 (623/2 m). 
Check your work in "Vertex" mode as the width of the Standard Reference is 12.3 m and the length 
of 623 m by selecting opposite vertices. 
Rename "EPiste" to "Etalon" (Sandard scaling length) and lock with an L/G on the padlock. 
Save by "File -> Save" in the Lienz creation folder with the name "AeroLienz". 
 

Figure 46 - Étalon de Piste/Runway Scaling reference. 
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Inserting the Google Earth Map "LienzGEMax" 

Make sure the textures are visible in Wings 3D: the item menu "Show Textures" must be checked in 
"View -> Show -> Show Textures". 
 
R/D in the window "Geometry", then R/D on "Image Plane". 
Select "LienzGEMax" in the Doc folder. 
In the "Image Plane" dialog box, select "Top" (top view). Then L/G on OK. 
 
Preparing image for scaling 
 
As the image will be very much enlarged and it is not 
really on a plane, but on a rectangular parallelepiped of 
very low thickness, bad selections can lead to distortions 
and artifacts. 
Here is the method to make " Image Plane " really flat 
with the image superimposed on both sides: 
1/ Make an L/G on the "Etalon" eye in "Geometry Graph" 
in order to only work on the "LienzGEMax" image. 
2/ S/E: deselect all with space bar, and switch to Face F. 
Mode 
3/ Select the 2 faces of the map, containing the images 
by 2 L/G. 
4/ R/D -> L/G on "Extract" -> L/G on "Normal". Move the 
mouse to increase the gap between the extracted faces. 
L/G to fix the gap. S/E deselect all. 
5/ In "Geometry Graph" there are now 3 objects "Image": 
Image2, Image2_extract3, Image2_extract4. Eliminate the initial image: R/D on Image2 -> "Delete". 
6/ Switch to Face Mode (press F) and select the inner faces of the extracted images and check by 
changing the camera's viewing angle that you have selected only these two faces. 

7/ R/D -> L/G on "Bridge". 
8/ Now, it remains only to reduce this 
parallelepiped to zero thickness. 
9/ Select a Vertex in Vertex Mode, Press K -> 
R/D on the opposite vertex and repeat for the 
remaining 3 vertices, starting from the same 
plane. 
10/ "Tools-> Center -> All" will put the object 
centered on the Wings 3D center O. 
11/Rename remaining "Image2_extractx" in 
"LienzGEMax". Go to Object mode with O, L/G 
on the image. You notice in the Status Bar that 
the object "LienzGEMax" has only 2 faces, 4 
edges and 4 vertices. 

  

Figure 47 - Options d'Image Plane/Image Plane 
Options. 

Figure 48 - Réduction du plan d'Image plane en une surface 
d'épaisseur nulle/Reducing the thickness of Image Plane 
Map to zero. 
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Scaling and Orienting 

1/ Display the "Etalon" again: L/G on the eye, and switch to Wireframe mode, L/G on the icon on the 
far right. The padlock on "Etalon" must be closed during the whole process. 
2/ Rotate the Image: Image selected in Object or Face mode, Y -> R/D in "Geometry" -> Rotate -> Y -> 
Rotate the image to the desired position, L/G to fix the new position. 
3/ Scaling: The image is still selected, "R/D -> Scale Uniform", move the mouse to increase or 
decrease the scale, L/G to fix. Proceed in several steps to obtain a runway length on the image close 
to the length of the "Etalon". 
4/ Stay in Face or Object Mode. With "Move -> X" and "Move -> Z", position the runway of the image 
on the Etalon. Fine-tune the orientation with "Rotate Y" and zoom in on one end of the runway with 
the mouse wheel. 

 
5/ To make the final adjustment it is necessary to proceed with a converging method: 
Tuning Sequence: 
a - Align the end of the runway threshold on the "image" (i.e.: LienzGEMax image) with the threshold 
of the "Etalon". 
b - Go to the other threshold of the "Etalon", zoom in, and have a look to the gap between the 
thresholds of the runway and the "Etalon". Then "Scale uniform" in order that the new position of 
the runway threshold on the "image" moves to half of the initial gap. "Scale Uniform" by moving the 
mouse with the CTRL+Alt keys pressed to control the scaling. L/G to fix. 
c - Then, on the same side set, with "Move X" and "Move Y", the threshold of the runway in the 
image on the threshold of the "Etalon". Correct the orientation if necessary with "Rotate Y". 
d - Go back to the first threshold end to see if the setting is correct. Otherwise, make a "Scale 
Uniform" of half of the gap between the runway of the image and the Etalon. 
 

Figure 49 - Technique de mise à l'échelle/Scaling Technique 
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Then start again the sequence from "a". After 3 cycles, you must have a perfect setting. 
Remember to lock the image and save the airport in Wings 3D. 

Inserting OSM drawings and the Patch 

Proceed in exactly the same way as before. 
Then carry out a general check. There will always be small differences, less than the meter between 
the Google Earth photo and the OSM plane, because it is not exactly the same projections. 
 

 
Figure 50 - Les 3 Plans alignés et mis à l'échelle/The Three Maps scaled and lined up. 

4/ Airports Surface Elements 

The surface elements are limited to 4 objects integrated in Condor2: "Asphalt", "Grass", 
"Asphaltpaint", "Grasspaint", of which here are the textures: 
 

 
 
The conditions of use of these 4 objects on the ground are the following: 
- "Asphalt" and "Grass" must not overlap. 
- "Grasspaint" must be reserved only for the markings on Grass. 
- "Asphaltpaint" can be used either on "Asphalt" and "Grass" for markings. 

Figure 51 - "Asphalt", "Grass", "Asphaltpaint", "Grasspaint" Textures. 
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- Unlike "Asphalt", "Grass" is visible only when approaching the ground during the landing. It must 
therefore be ensured that there is an adequate underlying layer under the "Grass" texture in the 
airport. 
- If you want to incorporate 3D frangible markers or any other object that does not cause a collision, 
use "Asphaltpaint". 
- If, among these 4 elements, one or more is composed of several objects, they must be combined 
before being exported in "Wavefront" in a single object. 
- It takes at least 1 of these 4 elements to create a G file of an airport. 

Creating "Asphalt" element 

"Asphalt" elements include: hard runways, taxiways, car parks, hangar floors, etc. 
 
Open 3D Wings and load the file "AeroLienz", switch to "Orthographic" mode, type Y, to see 
everything from above. 
 
As the "Etalon" corresponds to the runway, the runway is already done: 
R/D on "Geometry Graph", L/G on "Create Folder". Name the new folder "Asphalt". 
L/G on Images, R/D on "Etalon", L/G on "Duplicate". Unlock "Etalon_copy", L/G to select it, R/D on 
"Asphalt", L/G on "Move to Folder". The folder "Asphalt" contains 1 object "Etalon_copy", Rename it 
"Piste", deselect all and lock the element "Piste" (L/G on the padlock). 
Return to the Images folder. Hide all except "Lienz GEMax", by L/G on the "Eye" icon of the other 
elements.  
 
Except for very simple "Asphalt" zones, it is uncommon to use only one "EPiste" primitive. 
"File -> Merge -> EPiste" in "Aeroprimitive", then move this element  
 

 
Figure 52 - Construction de Taxiway1, 1ére étape/Building Taxiway1, 1st step. 
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In "Asphalt" folder.Rename "EPiste"in 
"Taxyway1". 
Switch to Vertex mode by pressing the V key. 
Then type H to move to the right with the 
mouse this new item, as figure 52. 
 

Figure 54 - 2éme étape/2nd step. 

Figure 55 - 3éme étape/3rd step. 

Figure 53 - Préparation de la 2éme étape/Preparing the 2nd step. 
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Deselect by S/E. 
Unlock "Piste". 
Type V to switch to Vertex Mode and select the upper left corner of Taxiway1. 

Type the keyboard shortcut J, the Vertex is highlighted 
(figure 53). 
 
Put the mouse cursor on the top right corner of the 
runway. This one takes the color of preselection. R/D, 
and the first Vertex is moved exactly on the top right 
of the runway, with the same coordinates (figure 54). 
 
Deselect all S/E. 
Repeat these operations for the lower left-hand 
corner of the Taxiway1 to overlay it on the lower 
right-hand side of the runway. 
Lock "Piste" and move the left-hand vertices with the 
H and N keyboard shortcuts on both sides of the 
Taxiway on GE Image (figure 55). 
Select the top edge and divide it by 10: 
R/D -> Cut -> 10. 
Then add the rightmost vertex to the selection with an 
L/G. 
Move this selection by H and N so that the leftmost 

vertex is on a representative point of the taxiway on 

the Google Earth image. Once this Vertex is 
properly positioned, deselect this Vertex and 
repeat the same operations to place the next 
Vertex, and so on. Do not worry about black 
lines that show momentary overlaps. When 

you have only 1 vertex left to move, 
reposition the vertex that has not been 
moved and reload the last edge in vertices. 

Figure 56 - Taxiway1 à moitié terminé/Taxiway1 half-finished. 

Figure 58 - Taxiway1 terminé/Finished. 

Figure 57 - Mise en place de Taxiway2/Positioning Taxiway2. 



Version 1.0 en - 2019-09-16  Page 58/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

This line of 10 or more vertices should be used as 
a ready-to-use vertex loader that follows the 
movement and stays near the last aligned vertex 
(figure 56). 
 
Continue the same operations as before, 
remembering to save your Wings 3D file from 
time to time. Optionally change Edge to divide by 
10. 
 
Another modeling technique consists in aligning 
the vertex so that the edge, which connects it to 
the last vertex correctly positioned, tangents the 
curve or aligns with the right segment, without 
taking care of its position. Then, to bring the 
vertex into its final position, an R/D to display the 
transformations in Vertex Mode, then an R/D on 
"Move" to be able to select the Tangent or 
Aligned Edge (possibly type E to select the Edge 
mode). Then, drag the vertex along this edge 
until you reach the desired position by moving 
the mouse. Finish with an L/G to fix the position 
and an L/G on the vertex to deselect it, before 
going on to the next. 
 
To avoid any error, always position the vertices 
on the perimeter of the "Asphalt" zone under 
construction by turning in the same direction, 
except in particular cases. 
 
To build the other elements "Asphalt", merge a 
new "EPiste", transfer it to the folder "Asphalt" 

and name it "Taxiway2". 
Place this new element along the edge of the Runway: 
Select Taxiway2 in Object mode: L/G on Taxiway2 -> O. 
Movement: R/D -> L/G on "Absolute Commands" -> L/G on 
"Snap". 
Switch to Edge mode, type E. Then L/G on the Taxyway2 
upper edge and R/D to confirm the selection. 
Unlock "Piste" then R/D on the lower edge of the runway. 
Taxiway2 is located along the runway, and the runway 
element is automatically locked. 
Switch to Vertex mode, key V and move taxiway2 along the 
runway with H (figure 58). 
Then, use the techniques developed above to model 
Taxiway2. 
 
The junction with taxiway1 is done with the keyboard 
shortcut J in the following way: 

Figure 59 - Taxiway2 en cours/Taxiway2 in progress. 

Figure 60 - Taxiway2 terminé/Taxiway2 finished. 

Figure 61 - Mise en place de Taxiway3/Positioning Taxiway3. 
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S/E, deselect all, and select the next vertex of the contour. In Mode V, unlock taxiway2, type J, and 
R/D on the vertex of the path high. Deselect all, select in V Mode the next vertex of Tawxiway2, type 
J, R/D on the vertex of the low path. Lock Taxiway1. 
 
Continue modeling Taxiway2. But you will not be able to finish this part without adding a third 
"EPiste" because of the presence of grass surface inclusions. 
 
Merge a new "EPiste", name the Taxiway3 and move it to the "Asphalt" folder. 
Selecting one by one each of the Taxiway3 Vertices, with each time J, and an R/D, set Taxiway3 as 
shown in the figure 61. 
 
It only remains to add a few Vertices to complete Taxiway3. 
 
There is one last part to model in the lower left, including a path and a farmyard. 
 
Merge a new "EPiste", name it Taxiway4 and move it to the "Asphalt" folder. 

 
With the help of the previous techniques, model taxiway4. Then lock everything. 
 

Figure 62 - Finition des éléments "Asphalt"/Finishing "Asphalt" Elements. 
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To finish the "Asphalt" part, it is necessary to finish the "Piste" element adding some Vertices to it 
and model the 3 departures of paths and made the edges hard: 
Unlock "Piste" then E (figure 62). 
L/G on a longitudinal edge of the "Piste". 
R/D -> R/D on Cut. A new vertex is created at the end of the edge that is dragged along the edge by 
moving the mouse, to position it at the desired place. With this technique, place 8 vertices roughly 
around the yellow arrows in the figure 62. 
 
First, you have to set the technical vertices on the "Piste" to the 2 vertices that are connected to the 
Taxiway1 and using the keyboard shortcut J. 
 
Then we select the 3 edges between the vertices that have been positioned roughly; 
R/D -> L/G Cut -> 3. 
Then, with the keyboard shortcuts H and N you have to position the vertices to model these 3 starts 
of concrete path. 
If necessary, for the start of the path below the runway, on the left, insert one or two vertices to 
complete the modeling. 
 
"Asphalt" is finished. 
 
Check your work in detail. Adjust the position of few vertices if necessary. Lock everything and save 
the airport. However, if you use "Muck" to create "Asphalt" textures with different colors or textures, 
and to avoid edge effects, you have to build the different elements "Asphalt" taking into account the 
limits of these different textures so that they are so many separate isles in the UV Map. At a 
particular texture on a bounded surface must correspond a particular "EPiste" element. 
 
Here is the result of Lienz-Nikolsdorf with the 3 maps T4570, UTM_OSM and GE: 
 

You can note that we first referred to the tile 
AA2, where the airport will be integrated. 

Creating "Grass" elements 

Traditional method: 

Create a folder "Grass". 
We must proceed in almost the same way as to 
create an "Asphalt" element, except that it is 
necessary to superpose the vertices of "Grass" 
on the vertices of "Asphalt" with the keyboard 
shortcut J. Most of the vertices delimiting the 
airport area will be placed with the H and N 
keyboard shortcuts. 

Figure 63 - Éléments "Asphalt" dans les 3 plans/"Asphalt" elements in the 3 maps. 

Figure 64 - Grass1 en cours d'élaboration/Making of Grass1. 
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- Merge an "EPiste". 
- Rename "EPiste" in "Grass1". 
- Move "Grass 1" to the "Grass" folder. 
- Place 2 consecutive vertices on 2 consecutive vertices of "Piste" using the sequence: 
V -> L/G to select the (next) vertex of "Grass1" -> J -> R/D on a vertex of "Piste" -> S/E. 

("Piste" must be unlocked in this 
process) 
- Select one of the adjacent branches of 
the quadrilateral: R/D -> Cut -> 10 -> 
L/G. 
- Using H and N place one or two 
vertices at the periphery. 
- Continue the superposition of the 
vertices with the sequence J. 
 
By merging a new "EPiste" and 
following the same process, "Grass2" is 
created. 
By repeating the same operations, for 
each of the remaining "Grass" elements, 

"Grass3", "Grass4", "Grass5" will be created. 
 

You will notice that it takes as many "Grass" vertices as "Asphalt" vertices if "Asphalt" is totally 
included in "Grass". And we must add the peripheral vertices delimiting the area of the airport. 
 
At this point, the "Grass" zones 1 to 5 are finished. 

Figure 65 - Grass1 terminé/Grass1 finished. 

Figure 66 - Tous les éléments "Grass" terminés/All "Grass" elements finished. 
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Boolean difference method 

Although the traditional method is perfectly safe, there is a Boolean difference method, much more 
elegant and often faster, but more difficult to implement. 
 
There are two factors that do not support the Boolean functions of Wings 3D: 
- Elements of zero thickness. 
- The coplanarity of 2 surfaces. 
Although Boolean algebra easily admits these two cases, these incompatibility often occurs when we 
move from theory to the implementation of a computer calculation that always works with finite 
values. 
 
If one of these two conditions is encountered during the Boolean calculation, Wings 3D reports this 
anomaly by indicating that: 
- Coplanar plans were met. 
- An internal error occurred. 
Or the program runs in a loop indefinitely, without any warning. 
 
The Boolean difference with Wings 3D works in the following way between two objects that have 
common volumes and no coplanarity: 
- Select in Object mode the main object, on which the common parts with the second object will be 
destroyed, then: 
R/D -> L/G on "BOOLEAN Test" -> L/G on "Difference" -> Display the window: "Select the Object to 
subtract from" -> L/G on the object to be subtracted. 
After a few tens of seconds, the result is displayed. The object that has been subtracted has totally 
disappeared. It will only be necessary, on the upper surface that we will extract, to make the new 
element "Grass", to eliminate many superfluous edges and keep some of them. There will also be 
some holes to make, to get a new perfect "Grass" area. 
 
Here is the detailed method for Lienz-Nikolsdorf. 
 
- Save the file airport "AeroLienz", then create a copy of the airport by "File -> Save As" giving it a 
new name, for example: "AeroLienzTestBool". 
 
This copy is already loaded because the "Save As" function changes the name of the file for the new 
name chosen. It is then doable to work directly on it, while keeping intact the work already done 
during the last backup of the original file. 
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Preparation of the "Grass"element: 

 
 

- Merge a new "EPiste". Transfer it to the "Grass" folder and name it "GrassB". 
 
- Model the airport area. We can draw it from the external outline of the "Grass" elements already 
modeled, but for a new airport it is the standard method already developed for the "Asphalt" and 
"Grass" elements. 
This element of 15 vertices is built in a few minutes while to create "Grass" 1 to 5 it takes more than 
one hour to place the 210 vertices, despite keyboard shortcuts. 

Figure 67 - Création de l'élément "GrassB"/Creating "GrassB" element. 
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- Make the other elements "Grass", "Asphalt" and images invisible by R/D on the eye. 
- Select in Face Mode the upper face of GrassB 
R/D -> Extract - Y -> Tab -> 30 -> OK -> S/E. Repeat with 20 for the "Numeric Input" without S/E. 
- Select the underside of the first Extract -> Bridge 
- Rename this object to "GassBV". 
- Lock and make the 2 objects invisible.  
- Save the file. 
 
The object "Grass" is ready. 
 
Preparation of the "Asphalt" element: 
 
- Display the 5 "Aspahlt" elements (L/G and R/D on the eye) 
 
 - A little thinking is needed about coplanarity: 
* They are either an interference with the GrassBV element. But we built GrassB so that it does not 
happen: there are no common Vertices and Edges with Asphalt elements! 
* Either they are due to the connections between the different "Asphalt" elements which will 
become coplanar planes when going from the plane surface to the volume, in the same way that one 
operated for GrassB. 

Figure 68 - Création du volume GrassBV/Creating "GrassBV" volume. 
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Figure 69 - Reconnaissance des Arêtes coplanaires/Spotting coplanar Edges. 

Figure 70 - Arêtes coplanaires déplacées/Moved coplanar Edges. 
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To avoid this kind of trouble, simply move 
backward one of the common edges a few 
decimeters (1/10 of Wings Unit), noting the 
direction, because it will be easy at the end 
of the process to redo the initial geometry 
by welding vertices. 
 
- Separate the superposed edges of each 
element "Asphalt", to avoid coplanarity 
when passing to volume: R/D on the 
superposed Edge of the corresponding 
unlocked "Asphalt" element -> R/D on Move 
-> L/G on one of the adjacent Edges -> Move 
the mouse to make the gap -> L/G to fix. 
 
- Select in Face Mode, the 5 upper faces of 
the 5 elements "Asphalt" 

R/D -> Extract - Y -> Tab -> 50 -> OK -> S/E 
repeat the sequence with 10 for the 
"Numeric Input". 

- Bridge elements by elements, the lower "Extracts" (at 10 m) with the upper "Extract" (at 50 m), 
selecting the opposite faces: R/D -> Bridge. 
 
- Go to Object mode, select the 5 elements Extract (Extract_runway, etc.) then R/D 
-> "Combine". 
- Rename the result to "AsphaltBV" and lock. 
- Make all "Asphalt" elements invisible, except "AsphaltBV". 
- Save your file. 
- Make a copy of "AsphaltBV": R/D on "AsphaltBV" in "Geometry Graph" -> "Duplicate". 
 
The object "AsphaltBV" is ready. 
 
Execution of the Boolean difference: 
 
- Unlock "AsphaltBV". 
- Display and Unlock GrassBV. 
- In Object mode, select: GrassBV. 
 

Figure 71 - Création du volume "AsphaltBV"/Creating "AsphaltBV" 
volume. 
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Figure 72 - "GrassBV" sélectionné et "AsphaltBv" en place/"GrassBV" selected and "AsphaltBV" visible. 

 
R/D -> L/G on "Boolean Test" -> L/G on "Difference" -> L/G on "AsphaltBV" -> R/D to execute. 
 
Wait and hope (or pray) for a few tens of seconds if the objects are complex! 
 

 
Figure 73 - Résultat de la différence booléenne sur "GrassBV"/Result of the boolean difference upon "GrassBV". 

 
This new object is still called "GrassBV" and is in Object folder. 
Many edges were created during the boolean process. 
Most of these edges are superfluous, although they are recreated during triangulation when 
exporting to Wavefront. To avoid errors, except for simple cases, they must be carefully removed 
from the top surface only. 
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Here is a very enlarged example where it is obvious that 
between 3 consecutive vertices, an edge was created 
during the process, otherwise the process makes 
quadrangular areas. 
When removing Edges, be careful of angles. 
Beware of unwanted selections. 
If at any moment, you notice that Edges are 
automatically created, a Border Edge has been 
accidentally erased. Go back through several "Undo" and 
check the geometry of the object. 
 
 
The 7 bridges between the 5 elements must be kept with 
their 2 closing edges. 
 

In the final control, examine each corner with a sharp zoom and orthographic perspective, to check 
the integrity of your geometry and to eliminate the edges of the surface that might have escaped 
during the cleaning. 
 
- Select the 5 parts of the surface in Face mode. Bridges must not be selected. This is why we kept 
the bridge edges ends. 
 
R/D -> Extract -> Y. 
Tools -> Put on the Ground. 
Then move "GrassBV" below ground and lock it, then Y, then switch to Vertex Mode. Bridges on 
"GrassBV" allow you to identify vertices on the extract part and that has been moved to avoid 
coplanarity. 
On the extracted part, above the 7 bridges it is necessary to put back the 14 vertices moved in their 
initial positions by a welding on the vertex remained fixed. It is the opposite of the displacement that 
must now be performed to come back to original geometry. 

Figure 74 - Arêtes superflues/Unecessary Edges. 

Figure 75 - Arêtes nécessaires à la fermeture des ponts/Necessary Edges to close the bridges. 
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For each Vertex: 
V -> L/G to select the vertex -> K -> R/D on the vertex remained fixed (figure 77). 

 
Then select the 5 items, switch to Object 
mode and "Combine" them. 
Rename the extracted part combined in 
"Grass". 
 
Switch to Face Mode. Select the 5 lower faces 
of the "Grass" element. 
R/D -> L/G on "Hole". 
 
Select "Grass" in O mode, then switch to 
Mode E 
"R/D -> Hardness -> Hard". 
All edges are hard. 
Save your file by: 
"File -> Save" 
 
The element "Grass" is finished. 
 
But the "Asphalts" elements have been 
modified. 
To transfer "Grass" to the original file, 
proceed as follows: 

 
O -> L/G on "Grass" -> File -> Save selected -> 
Name: "GrassBol" -> L/G on Save. 
File -> Save. 
File -> Open -> "GrassBol". 

Then, you have to clean up the superfluous elements found in "Outliner" window of GrassBol, 
keeping and assigning to "Grass" one material and one texture and eliminating everything else: 
- Assignment to a material: O -> L/G on "Grass" -> R/D on "EPiste_auv" on "Outliner" -> L/G on 
"Assign to selection". 
- Rename this "EPiste_auv" in "Grass" 
- Elimination of other materials: R/D on "Episte_Auv2", etc.. -> L/G on "Delete" 
- Elimination of images. Only the image linked to the material will not be erasable: R/D on an image  
-> L/G on "Delete" or "Delete texture". Repeat these operations to eliminate the remaining images. 

Figure 76 - "GrassBV" prêt pour l'extraction/"GrassBV" ready for extract. 

Figure 77 - Élimination des sommets superflus sur l'élément "Grass" extrait de 
"GrassBV" pour revenir à la géométrie initiale/Eliminating the unnecessary 
vertices upon "Grass" elements, extract from "GrassBV", in order to come 
back to the initial geometry. 
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- Rename the remaining texture in "Grass". 
 

Figure 78 - Préparation de l'élément "Grass" pour la fusion/Preparing the"Grass" element for merging. 

- Edit the material: R/D on "Grass" on "Outliner" -> L/G on "Edit material" -> L/G on "Base Color" -> 
L/G on a green color -> L/G on OK -> File -> Save. The green color is only there to tint "Grass" in green 
in Wings 3D in order to make a difference between "Grass" & "Asphalt" in this tutorial. 
 
Save "GrassBol" file. 
 
The file "GrassBol" must be identical to the extract above to be able to be merged into the main file. 
Examine the "Geometry Graph" and "Outliner" windows carefully. 
Open "AeroLienz", and merge "GrassBol". 
Check in detail that everything is correct and save 
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Figure 79 - L'élément "Grass" booléen dans "Aerolienz"/Boolean "Grass" elements in "Aerolienz". 

Correcting "Grass" and "Asphalt" 

Several difficulties can arise when creating "Grass" and "Asphalt".elements.  

Elements flatness. 

To correct or ensure flatness, here is a method: 
O to switch to Object Mode. 
L/G to select the item "Grass" or "Asphalt". 
V to switch to Vertex mode. 
R/D -> Flatten -> Y to put all vertices on a plane perpendicular to the Y axis 
R/D -> Absolute Commands -> Move -> Absolute Move Option -> Y = 0, to set or verify that all 
vertices are on the ground. 

Correction of the perimeters of "Asphalt" and "Grass" 

The modifications of the perimeter of "Grass" and "Asphalt" can always be done, to add or remove 
vertices at any time of the creation of the airport. 
 
The only difficulty lies on the common contours of "Grass" and "Asphalt", where the Vertices of 
"Asphalt" are superimposed on the Vertices of "Grass". Just proceed with method. 
We must first identify the element "Grass" or "Asphalt" whose surface will decrease. Then you have 
to start the corrections on this element by unlocking it, then moving the vertices on a more adequate 
position. You may need to add extra vertices. Normally an empty space will be created between the 
two elements, especially if you add vertices. To fill it and avoid any overlap, unlock the adjacent 
element, add the same number of vertices as on the first element along the gap, and use the 
keyboard shortcut J to put all the vertices above each other. A more perilous method is to perform a 
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selection of vertices on both edges by drawing a selection box with the mouse and then moving the 
vertices. 

Overlap or empty space between "Asphalt" and "Grass" outlines 

In Wings 3D, overlaps are hard to find, but they affect the final render of the airport. They often 
occur when we have forgotten to deselect the vertex that we have just placed on the top of another 
element and that we move on to the next one, or when one skips a vertex in a perimeter between 
two elements. It is therefore necessary to carefully examine the geometry and then proceed with the 
corrections as indicated above. 
If you use the Boolean method, there is little opportunity of overlapping, but you can get a lot of 
empty space if you do not clean the superfluous edges correctly. 

Creating "Asphaltpaint" and "Grasspaint" Elements 

The "Asphaltpaint" and "Grasspaint" elements, such as numbers, arrows, bars, rafters are all 
standardized, according to ICAO Annex A (or Annex 14, book I in English). This 77-page document or 
its 352-page English version (Start Chapter 5) can be found and downloaded for free from the 
Internet. Just search. 
Here are 2 significant extracts, which will not dispense you from a deep reading, and from the 
creation of particular elements, to build as and when needed, in the form of primitives to merge in 
Wings 3D. 
 
The careful reading of all the documentation found on the Internet for Lienz-Nikolsdorf shows great 
disparities in the state of the airport, according to the date of the photos, with parts erased or very 
degraded. 
 

However, it appears from the viewing of the photos that there is a runway marked by ground 
markings on the grass, and 3D markers corresponding to the area of the full runway for planes and 
gliders and the landing areas for Helicopters and also standard markings on concrete runways. 

Figure 80 - Extraits de l'Annexe A/Samples from Annexe 14, book 1. 
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The t4570 tile also shows the presence of a circle with a windsock in the center and two white 
squares with an H. 
 
Creating specific primitives: 
 
To create the primitive "circle", start from a tube (R/D on the Cylinder primitive) in 32, or 64 sections, 
diameter 15, thickness 1.2. Extract the upper face, put it on the ground, harden the outer edges, etc. 

 
For the square, ditto from a 4-section tube. 
 
From "EPiste", you can create all the 
markings you want. 
 
Load "AeroLienz" into Wings 3D and create a 
folder "Asphaltpaint" and "Grasspaint" in 
"Geometry Graph". 
Merge the square, move and adjust to the 
1st location, duplicate, move and adjust to 
the 2nd location. Merge the circle, move and 
adjust to the location. 
 
Then we will take care of the markings of the 
runway. 

 
For this purpose we will merge objects 
already prepared and complying with the 

requirements of ICAO Annex A (or Annex 14, book I in English). 
 
First of all, you have to merge an "EPiste" to draw a rectangular support around the runway, to use 
as a rectangular line to align the lateral strips on the grass. This object renamed "Piste Herbe" will be 
transferred to the "Image" folder and it will be put in a wire frame (L/G on the Icon to the right in 
"Geometry Graph") and locked. 
 
Then we will merge the following elements already ready in our bank of signs: 
 
- A runway threshold that we will slightly modify, duplicate and place the second runway threshold. 
- 4 threshold bands of that we will also duplicate and place 
- A 12- 30 runway orientation marking that will be reduced to being adapted to the dimensions of the 
concrete runway. 
- A runway axis that we will duplicate to cover the runway length. 
These elements will be grouped in "Asphaltpaint". 
 
Then we will finish the "Asphaltpaint" elements by boundary markers of the airstrip area of planes 
and helicopters with pyramidal frangible markers (3D) and placing stop stripes of on the taxiways. 
 
For Grasspaint elements, side markings on the grass runway are present, although often very erased. 
We proceed in a similar way to that used for the construction of "Asphaltpaint" elements. 
 
Here is the final result: 
 

Figure 81 - Cercle et Carrés Asphaltpaint/"Asphaltpaint" 
Squares and Circle. 
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Figure 82 - Disposition des éléments "Asphaltpaint" et "Grasspaint" sur la piste/General lay out of "Asphaltpaint" and 
"Grasspaint" elements upon the runway. 

5/ Creating airport buildings, hangars, control tower, etc. 

We must create about fifteen buildings for Lienz-Nikolsdorf. 
Viewing the photos, there seem to be 3 control towers, 2 of which are unused and 3 windsocks. 
 
All the buildings will be modeled first, before being unfolded and textured, in order to separate and 
analyze the 2 steps of this creation process, but nothing prevents you from doing these 2 steps one 
after the other during the creation of the buildings. 

 
Objects of this type are all objects that will cause crashes 
when collided. 
As previously stated, we will only create objects that are 
static by destination. 
 
Create a folder we call "Hangar", where all the buildings in 
the O file of the airport will be collected. 

Building Modeling 

Hangar HLn01 
1 / Merge Hn, migrate HLn to Hangar, rename it to HLn01 
and move it to the flat-roofed hangar at the far right 
bottom. Check that you are in top view and in 

orthographic projection. Examine the photos of this 
hangar in the "Doc" folder created in Chapter 1 of the 
modeling. 
 

Figure 83 - Positionnement de HLn01 sur le hangar à 
modéliser/Hangar HLn01 positioned upon the hangar to 
model. 
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2 / Orient the primitive so that the edges of the building are parallel to the borders of the map of this 
Hangar:  
S/E -> L/G on HLn01 -> O -> R/D -> Rotate -> Y -> Move mouse -> L/G to fix the position. 
 
3/ Select a lateral face and move it on the border of the plane of this hangar: 
S/E -> F -> Selecting a face -> R/D -> Move -> Normal -> Move the mouse -> L/G to fix. 
 
4 / Select an adjacent face and repeat the operation. 
 
5 / If necessary finalize the orientation. 
 
6 / Repeat step 3 for the other 2 remaining faces. 
 
7 / Now we do not change the height of the hangar. When building the other buildings, to respect 
the proportions, the height will be lowered to 6.2 m. 
 
Hangar HLn02 
We choose to model the adjacent hangar. 
The examination of the photos shows that we are in the presence of several adjoining buildings. 
Here are the only pictures available: 
 

 
Figure 84 - Photos de HLn02/HLn02 pictures 

1 / Repeat previous operations 1 to 6 for HLn02, without worrying about the general distortion. 
 
2 / Cut the different parts of the building by creating lines at 1/5 along the X axis and 2/3 along the Z 
axis 
 

3 / Then, extrude the roof slightly and a second time 
for the slightly elevated part 
 
4 / Create the roof edges by selecting the 4 
perpendicular edges then C. 
By "Move Y" raise the ridge slightly, to give the slope 
to the roofs. Help yourself with photos and go into 
perspective mode to appreciate the relative slopes. 
Lower the edge of the shed. Be careful the edge of 
the roof should be between 2.7 m and 3 m. 
From this reference, you can practically find all the 
relative positions of the heights of the building by 
helping you with photos. It's much more precise than 
you might think, because the human eye is ultimately 
very effective. 

 
Figure 85 - Modelage de HLn02/Modeling HLn02. 
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5 / By selecting the right building edges, we will move the building back in 3 steps, so that it is in 
accordance with the OSM map. 
- The first move along the X axis, concerns the positioning of the separation between hangar and 
offices on the boundary of the building. 
- The second move, always along the X axis, after having deselected the correctly placed edges, is to 
align the lateral face of the offices on the boundary of the building, so that everything is aligned 
correctly, in particular the ridge of the roof . You will find that everything is correctly positioned, 
except 2 vertical edges and the rear face of the building. 

- The third move, along the Z axis, after selecting 
the vertical rear edges of the offices consists of 
two movements as previously to align them to the 
boundaries of the building according to the OSM 
map. All that remains is to align the rear end of 
the roof ridge on the boundary and check the 
flatness of the faces of the building. Some 
alterations may be necessary. 
 
6 / It remains only to add the 2 extensions on the 

side parts by extrusion along the normal, after 
creating the cutouts of the corresponding vertical 

walls. Then lower the upper edge, to adapt the slope of the roof. 
 
7 / You must then eliminate superfluous Edges and Vertices and harden the Edges, to finish one of 
the most complex hangars to model. 
 
Hangar HLn03 
This is the so-called control tower at the back of the HLn02 hangar. 
 
1 / Merge Hn, move, rotate, adapt the geometry, adjust the height. 
 
2 / Select the 2 upper edges, cut and lift to make the roof. 
 
3 / Exceptionally for the visual rendering, it is necessary to create the big roofing overlap. 
Proceed as follows: 
S/E -> F -> Select the 2 sides of the roof -> R/D -> "Extrude" light -> S/E -> F -> Select the roof edge 
surfaces -> R/D -> "Extrude" -> "Normal" -> Move the mouse until you get the desired effect. 
 
4 / Eliminate superfluous generated Edges. Make all the edges hard. 
 
3 / Finish everything by helping you with photos. 
 
Hangar HLn04  
This is the half-octagonal control tower lined against the hangar HLN02. 
 
1 / You must first create an appropriate primitive. 
Launch a new instance of Wings 3D. 
R/D -> R/D on "Cylinder" -> Fill in the options "Sections" 8 and check "Put on Ground". 
S/E -> O -> L/G on the octagon -> R/D -> Rotate -> Tab -> 22.5° -> OK. 
S/E -> V -> Select the first 4 points in the positive Zs at 0.382 -> C. 
S/E -> E -> Select one of the 2 edges parallel to X -> L (Loop) -> R/D -> L/G on "Loop Cut" -> Eliminate 
the highlighted part -> R/D on "Cylinder1_cut2 " in "Geometry Graph" -> L/G on "Delete". 
S/E -> V -> Select 2 opposite vertices of the octagon on the upper face -> C. 

Figure 86 - HLn02, 03, 04 terminés/finished. 
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S/E -> E -> Select the Diameter edge that has just been created -> R/D -> L/G on "Cut" -> L/G on 2. 
S/E -> V -> Select the central vertex and one of the 4 vertices -> C. 
Repeat with the remaining 3 vertices. 
S/E -> E -> Select Edge//X on the upper face -> R/D -> L/G on "Cut" -> L/G on 2. 
S/E -> V -> Select this new vertex and the Central vertex -> C. 

S/E -> F -> Select the bottom and the back -> R/D -> L/G on "Hole". 
Repeat if necessary. 
S/E -> O -> L/G on "Cylinder1" -> E -> R/D -> "Hardness" -> L/G on 
"Hard". 
 
The new primitive is ready. Rename it HLn and save it in 
"Aeroprimitive" under the name "OctogT". Close this instance of Wings 
3D. 
 
2 / Merge an instance of this primitive into "AeoLienz". 
Rename it HLn04 and migrate it to Hangar. 
Move it against the HLn02 hangar as follows: 
S/E -> O -> L/G to select HLn04 -> R/D -> L/G on "Absolute Commands" 
-> L/G on Snap -> L/G to select a Vertical End Edge -> R/D to confirm -> 

Unlock HLn02 -> L/G on the vertical edge of the shed -> R/D to perform the action. 
 
By "Scale Uniform", "Moves" on and along the facade, and successive controls, position and scale 
HLn04 hangar, until getting something satisfactory compared to the photos. 
 
Make the "sill" at the bottom of the windows: 
S/E -> E -> Select Vertical Edge -> G -> C -> S/E -> E -> Select Upper Vertical Edges -> G -> C -> 
"Move Y"-> Position Top of sill Edges-> E -> R/D on "Scale Uniform"-> M/C -> L/G on the upper 
central rear vertex -> R/C to execute -> Move the mouse to form the sill -> L/G to fix. 
By moving the horizontal lines, adjust the "sill" to get something satisfactory compared to the 
photos. 
 
Hangar HLn05: 
It is a wall surrounding 3/4 of an area containing 
weather devices. 
Merge a new primitive Hn: S/E -> File -> Merge  
-> Hn 
Rename it HLn05. 
Reduce the dimensions to: width 0.3 m and 
height 0.90 m with "Absolute Commands". 
Select the right end in Face mode with an L/G. 
R/D -> Sweep -> Sweep -> Y -> Tab -> D = 5,  

A = 45 °. 
Repeat with the same values. 
From this element, move, rotate, decrease, etc., to adapt the wall to the plans. It is not quite 
rectangular. 
 
Hangar HLn06: 
this is the new control tower in a prefabricated building, with an external staircase, placed on a metal 
structure 2.5 m above the ground and an overpassing roof. 
The estimated dimensions are 2.4 x 6.2 m height 2.5 (that of a Standard prefabricated module). 
 

Figure 87 - Primitive "OctogT". 

Figure 88 - HLn05 Option de Sweep/Sweep Options. 
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In the absence of a primitive, we start from 
a cube with evoked dimensions that we 
rename HLn06 and that we move to the 
"Hangar" folder. 
 
Then it is positioned above the wall. The 
roof is built as for HLn03. the 4 feet and the 
stairs are only a sequence of cutting of the 
faces concerned, followed by extrusions. We 
do not put steps. But we must create the 
stair railing with a particular element 
starting from a primitive cube of 1 x 0.1 x 0.1 
m that is duplicated after unfolding, as many 
times as necessary. This object is called 

"Barre". 
 

The modeling of the first group of buildings is completed. Some changing was done on "Grass" and 
"Asphalt". 
 
Hangar HLn07 
It is a technical building in the shape of a simple parallelepiped that can be modeled in a few minutes 
following the techniques developed above. 
 
Hangar HLn08 
This is the offices adjoining the previous hangar, with a half-circle glazed advance forward. 
There is no difficulty in doing this building. Watch out for projections in OSM plans. The buildings are 
rectangular. The little deformations visible on the OSM plane are due to the UTM projection 32N 
distant from the reference meridian. 
 
Hangar HLn09 
Standard hangar that is created in less than a minute from the primitive Hn. 
To create the double slope roof: 
Select the edges perpendicular to the ridge and type C. Then lift them with "Move Y". 
Adapt the geometry. 
 
 
Hangar HLn10 
Hangar almost identical to the previous one. It is easy to add the extension by cutting and extrusions. 
 
Hangar HLn11 
Standard hangar created in less than 5 
minutes from the primitive Hn. Only the 
height must be adjusted in view of the 
photos. 
 
 
Hangar HLn12 
This is the fuel delivery station. The photos 
show that there are 5 pumps, which are 
protected under a light shelter. For safety 
reasons, the pumps are always on a 

Figure 90 - Le poste de combustible/Skid fuel. 

Figure 89 - HLn06 terminé/Finished 



Version 1.0 en - 2019-09-16  Page 79/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

concrete block 20 cm above the ground. 
From a Hn primitive, the 20 cm base is created to the outer dimensions of the area on the OSM 
board. Then you have to make two "Extract" according to Y and a "Bridge" to create the light roof 
that is placed at 2.5 m high and then made it invisible. 
The base is slightly reduced by a "Scale uniform" and then put on the ground. 
The body pumps are created as follows on the upper face of the base: divide the lateral edges in 3 
and connect. Then divide these new edges into 11 and connect them. Extrude the 5 pump bodies to 
the height of 1.8 m absolute. Adapt sizes and areas of body pumps if necessary. 
Back on the roof, reduce the thickness to about 2.5 cm. On the underside of the roof, create 4 
starting of square pillar outlines inside the roof edge. Extrude the pillars and ground the end faces. 
Select the roof object in Object mode, switch to F mode. With L/G deselect the 10 faces of the front 
pillars. Then R/D -> R/D on "Rotate" -> E to choose an axis of rotation with an L/G, the lower edge of 
the roof at the front -> R/D to rotate -> L/G to set the amplitude (10 ° approximately). S/E -> Select 
the lower faces of the rear pillars -> R/D -> Flatten -> Y -> Absolute Commands -> Move -> Y = 0 -> 
L/G on OK. Combine the roof with the pumps. 
The fuel station is finished. 
 
Hangar HLn13 to HLn17 
These buildings are part of a farm and its dependencies, whose modeling is very simple from the 
primitive Hn. 
Always proceed in the same way: 

- Merge Hn 
- Rename Hn in HLn13, etc. 
- V -> H and N to roughly position the 
building on the OSM image. 
- Rotate Y to orient it then H and N to 
position one or two edges correctly. 
- Select Face -> R/D -> Move-> Normal -> Y -> 
Adjust the position of the face -> L/G to fix. 
Move to the next side, etc. 
- Select the opposite edges to make the ridge 
of the roof -> C -> Move Y -> Move the 
mouse -> L/G to fix -> R/D -> Hardness -> L/G 

on Hard. 
- Adapt the height of the building according to the photos 
- Move the object to the Hangar folder -> Lock. 
 
Masts and Wind Direction Indicators 
The international forum offers a windsock with its mast that you can use called "Windsock Pole" 
among other static objects. 
 
http://www.condorsoaring.com/assets-library/ 

 
However, we consider that the definition of 
the mast is too detailed and so we have 
created a particular simple hexagonal object 
that we will merge with its texture. 
 
The windsocks consist of a "Mast" and an 
object that automatically generates a wind-
blowing windsock called "Windsack" which 
is a flat isosceles triangle. The length of the Figure 92 - Mât et Manche à Air/Pole and Windsack. 

Figure 91 - Les bâtiments agricoles/Farm buildings. 

http://www.condorsoaring.com/assets-library/


Version 1.0 en - 2019-09-16  Page 80/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

windsock is 100 times the triangle’s circumscribed radius. It has a standardized minimal length of 4.5 
m in view of Annexes A or 14. Three windsocks can be merged into one airport with the names 
"Windsack1", "Windsack2", "Windsack3". 
For Lienz-Nikolsdorf, you have to create 3 windsocks and a simple weather mast. This weather mast 
supports a wind vane and a reel to measure the wind speed. These two objects are too small and 
complex, and they will not be modeled. 
 
Merge a windsock: 
There are two objects: as shown by the "Geometry" and "Geometry Graph" windows. 
These two objects must be moved simultaneously in Object Mode in the "Geometry" window, to be 
positioned on the center of the circle. 
Move the 2 objects in the Hangar folder by "Move to Folder" and lock. 
 
Merge a second windsock. Rename "Winsack1" to "Winsack2". Move and position both objects 
simultaneously in the weather enclosure (Hln05). 
Duplicate the object "pole" and move and position the copy in the enclosure for the weather mast. 
Combine the two objects "Pole" and "Pole_Copyx". 
Move the 2 objects in the Hangar folder by "Move to Folder". 
Merge a third windsock. Rename to "Windsack3" if necessary. Position this windsock on building 
HLn08, against the wall of building Hln07 and a little bit in altitude. Move these two objects in the 
Hangar folder. 
Combine the three objects "Pole". 
Save the file "AeroLienz". 
 

Figure 93 - État de "Aerolienz" en fin de modélisation/"Aerolienz" at the end of modeling. 

 
While limiting the modeling to static objects by destination, it is still possible to add, at this step 
many other objects to complete the modeling of an airport, such as fences, benches, umbrellas, etc. 
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Snap Image, UV Map, Textures 

As the modeling is finished, it's time to review the main ways to make buildings more appealing in 
simulation by covering them with realistic textures. The general rules for the complete texturing for 
only one or two buildings of Lienz-Nikolsdorf will be explained in this document. 

Snap Image 

The best way to cover the buildings with a realistic texture is to have a photo for each side of the 
building, as explained in the chapter on documents to gather to create an airport. As our appeal to 
the community has remained unanswered, we do not have adequate photos for the hangars of Lienz-
Nikolsdorf. 
So we will show how to do this pinning with another hangar's picture. But we will not retain this 
mounting in the finalization of the airport. 
 
The utilized photos can be previously straightened in a photo-editing software and unwanted 
elements erased. But "Snap Image" Wings 3D application has enough tools to straighten the photo. 
On older versions of Wings 3 D "Snap Image" was a tool, now it has become a full application and has 
its own window accessible through the Window menu: 
"Window -> Snap Image". 
 
However, it is necessary to have previously loaded the images to be applied on the faces in order to 
select them. Be careful, always work on copies of your images. 
For our example, we have loaded a photo of a front side of a hangar, not very well adapted to the 
hangar HLn09. This is done through the menu: 
"File -> Import Image...". 
 
This opens a dialog box allowing you to choose the desired image. 
The image appears in the "Outliner" window in the "Images" folder. 

 
Figure 94 - Image de départ/Starting Image. 

It is then time to open "Snap Images" and to position the face correctly  or faces where the image 
should be pinned. The axis of the camera should initially be perpendicular to the average plane of the 
face in orthographic mode. 
 
The options in the window include 3 buttons for the 3 main steps of "Snap Image" and 2 options and 
4 tools to move and scale the image. 
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Figure 95 - Snap Image. 

 
The differences in appearance between the image and the front door of HLn09 are important. 
 
After various uses of "Snap Image" tools, Moving and scaling mainly vertical. The final alignments are 
done by reorienting the face of the hangar skillfully in orthographic mode or in perspective mode in 
the "Geometry" window, to obtain this: 
 

 
Figure 96 - Adaptation réciproque de l'image et de la face du hangar/Reciprocal adaptation of Image and Hangar's face. 



Version 1.0 en - 2019-09-16  Page 83/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

This is an extreme example, almost impossible, but representative of what we can do with "Snap 
Image". Here is the final result, once the image is selected, the pinning is finalized by an L/G on the 
button "Snap Image" and an L/G on the cross of the Snap Image window, to exit this mode. 
Note that a default material has been created called "Default_Name of Image" highlighted in yellow 
in Figure 95 with which the associated image. 
 

 
Figure 97 - Le résultat de "Snap Image" dans Wings 3D/Result of "Snap Image" in Wings 3D. 

If only a part of the faces of an object is pinned on Images, the general unfolding (UV Map) must be 
done only after the selection of the faces not concerned by this process. Otherwise all the pinning 
process must be redone. 

Unfolding, UV Map 

The unfolding process consists in creating 
the "UV Map", which will allow at the 
end of the process to create the "Texture 
Map". 
 
Since almost all hangars are simple 
rectangular parallelepipeds that have 
sometimes been fitted with single or 
double slope roofs and most of them 
have no bottom face, Wings 3D standard 
and automatic unfolding is required and 
will be more than sufficient: 
 
Unlock the HLn10 hangar. 
 
O -> L/G sur HLn10 -> R/D -> L/G sur UV 
Mapping. 
 
The "AutoUV Segmenting: HLn10" 
window opens. This is the window where 

Figure 98 - Segmentation standard dans "AutoUV Segmenting". 
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we practice the segmentation of the object HLn10. Since this window is centered on the center of the 
scene, nothing is usually visible because the object HLn10 is very far from the center. To observe 
what will happen next, reduce the zoom level with the wheel mouse until the displaying of HLn10. 
L/G on Hln10 to make a selection, then A to re-center the camera on HLn10. Zoom with the wheel 
mouse to examine closely the object. If the preparatory work has been done correctly, all the edges 
are hard and the cutting by faces will be done automatically. The bottom face is absent. If this is not 
the case, close the "AutoUV Segmentting" window and correct the geometry, save and repeat the 
unfolding with an R/D instead of an L/G on the item "UV Mapping" to start again on a new unfolding. 
 
Then do an R/D in the "AutoUV Segmenting" window to bring up the context menu. 
L/G on "Segment by" -> L/G on "Projection". 
 
The faces of HLn10 are colored according to the isles that will be drawn on the UV Map. Note that 
the double slope roof forms only one isle, because the angle between the 2 faces is close to 180 ° and 
so there will be only slight deformations during the projection. 
 
Then, new R/D in the "AutoUV Segmenting: HLn10" window to bring up the context menu. 
L/G on "Continue" -> L/G -> "Projection Normal" (Projection according to the Normal of each face). 
 
The "AutoUV Segmenting" window disappears, it is replaced by the "AutoUV: HLn10" window. It is in 
this window that we will proceed to the arrangement of the isles on the UV Map. To execute the UV 
Map arrangement, there are many tools that are called by an R/D in the "AutoUV" window according 
to the Selection Mode. 
We leave it to you to examine them in detail, the information line informs you permanently when an 
item of the contextual menu is overflown by the mouse. 

Figure 99- Fenêtre "AutoUV"/"AutoUV" Window. 
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Figure 99 shows what appears when the "AutoUV" window opens and replaces the "AutoUV 
Segmenting" window. 
 
All the isles of the UV map and all the faces of the object in the "Geometry" window are selected. An 
S/E deselects everything and an L/G on an isle selects the face of the corresponding object in the 
"Geometry" window and vice versa. 
This is very convenient for identifying the faces of the object, especially since this window can be 
recalled at any time by the Menu: "Window -> UV Editor Window". 
 
To select everything, draw a selection rectangle with an L/G maintained in Face or Object Mode. 
Note that Object Mode selects complete isles, but not the complete unfolded object in the AutoUV 
window. 
 
All the faces of the object are presented inside the central square of the window surrounded by a 
thick blue border. The background of this central square is composed of letters that are currently a 
repeating square pattern that repeats itself 8 times in U (horizontally or X) and V (vertically or Y). 
 

This arrangement makes it possible to make clever calculations on the canonical 
coordinates UV between 0 and 1 and to which it will bind a map of texture most 
often in multiple of 2. 
The last interesting element is the blue-edged grid that extends the central 
square. It only tells you that the central pattern of the UV Map repeats infinitely 

in all directions in each square box surrounded by a blue border, which can be interesting if you 
create modular objects with a single texture with repeating horizontal or vertical patterns. 
 
The only defects of UV map, created automatically without our intervention, reside in the following 
observations: 
- The isles are connected and start right at the edge of the UV map. 
- The isle of the roof is inclined, while the texture patterns that we will apply are either horizontal or 
vertical. This angle comes from the angle of the building makes in Wings 3D with the X axis. 
 
All these small defects can be very easily corrected. 
 
 
Correction of the angle of the isle of the roof on the UV Map: 
S/E -> E -> Select an almost horizontal edge of the roof isle with L/G -> R/D -> L/G on "Rotate" -> L/G 
on "Chart to X". The isle of the roof is upright and the edges are perfectly aligned vertically and 
horizontally. If you select an almost vertical edge, do an L/G on "Chart To Y". 
 
Redeployment of isles on the UV Map: 
It is better, but it is not mandatory and systematic, to make margins around the isles and borders of 
the UV Map in order to get about 2 pixels between Isles' Edges and the UV map border and 4 pixels 
between the isles for a final Texture Map of 1024x 1024 pixels. This is often necessary to avoid side 
effects. When transposing UV coordinates from a UV Map into a Texture Map, there is a very small 
probability that each isle's vertex is on the exact coordinates of a pixel. And if your UV Map has 
sloping edges, it's even worse. Halftone pixels are often obtained on isle edges when texturing isles if 
we do not take these margins. 

A B C D 
E G H J 
K L M O 
P Q R S 
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Here is how we proceed: 
Switch to Object mode and 
select all -> R/D -> L/G on 
"Move" -> L/G on "Free" -> move 
the mouse to create a border 
margin around the isle of the 
roof -> L/G to fix or R/D to return 
to the starting position. 
 
S/E -> O -> Select the upper isle 
to the left with L/G -> R/D -> L/G 
on Move -> L/G on "Vertical" -> 
Move the mouse to separate the 
isle below -> L/G to Fix. 
 
S/E -> O -> Select the 5 isles on 
the far right with L/G or a 
selection rectangle -> R/D -> L/G 
on "Move To" -> L/G on "Right". 
All selected isles are with their 
right edges against the right 
border. They are all aligned on 
their right border. 
Keep these 5 isles selected -> R/D 

-> Move -> Horizontal -> Move the mouse to create a right margin without overlap with the isles to 
the left of the selection -> L/G to fix. 
Then deselect with an L/G the isle at the bottom of the selection -> R/D -> L/G on "Move" -> L/G on 
"Vertical" -> Move the mouse to separate the selection of the lowest island -> L/G to fix. 
Repeat the last sequence as many times as necessary to lay out the islands one by one keeping them 
aligned on their right edge. 
 
End-to-end, unfolding and corrections are made in less than 5 minutes. 
 
The definitive UV Map is finished. 

Texture Map 

To create the Texture map from the UV Map, proceed as follows: 
 
Switch to Object Mode and Select All Isles -> R/D -> L/G to "Create Texture" -> the "Draw Options" 
window appears. 
 
The always square texture map has a pixel size to be defined: choose 1024 x 1024 pixels. 
Then, when creating the Texture Map, a series of passes in the "Render" frame are executed in the 
order displayed from top to bottom in the "Draw Option" window, the next pass covering the 
previous pass . The stacking of the passes is therefore on the Texture Map from bottom to top. 
 
 
 
 
 

Figure 100 - Carte du Patron/UV Map. 
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Figure 101 - Options standard de la Carte de Texture/Standard Texture Map Draw Options. 

Configure "Draw Option" as per Figure 101, a standard Draw options. 
An L/G on OK draws a raw texture map and creates a HLn10_auv material associated with an image 
with the same name. 
 

 
Figure 102 - Carte de Textures Brute/Rough textures Map. 

It only remains to apply these same processes to the other 16 buildings of Lienz-Nikolsdorf. 
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Texturing 

The texturing of objects in Wings 3D with "Snap Image" has been examined previously. We will now 
examine the texturing of objects with an external 2D software to Wings 3D from the raw Texture 
Map that has just been created. 
 
In most cases, to be able to edit the Texture Map, you must make "external" the Texture Map. Once 
textured, the texture map can be easily updated in Wings 3D. 
 
Making a texture map external is easy. 
 
An R/D on the image of Hln10 in "Outliner" provides access to the context menu. An L/G on "Make 
External" opens a Windows dialog box. Create a new "Textures" folder in which you save the HLn10 
Texture Map in PNG format. This format is as efficient as the DDS format, and much better than the 
BMP or TGA format. 
 
Be aware, however, that you can change the type and size of any Texture Map at any time. This 
aspect will be evoked in Chapter 9, in the finalization of the airport. 
 
Open your 2D software and load the Texture Map. 
 
The first thing to do is to create a general layout of paths around each isle with the pen tool, 2 pixels, 
at least from the isles' border. Then lock the image, add a layer, and save to the format of the 2D 
software. 
 

Figure 103 - Travail de base sur la Texture HLn10/Basic work on HLn10 textures. 

Then for a correct rendering, it is necessary to use textures, except for the windows, the frames of 
doors and windows, the shadows of the overlapped roofs, which can also be made by coloring. 
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Many textures are available for free on the Internet. Prefer seamless square textures. Just search; 
but do not forget to mention your sources by including them in the "Read me" of the scenery. You 
can also create them directly from your own photo. 

 
for example: 
http://www.museumtextures.com/ 
 
http://soundimage.org/ 
 
https://www.google.cz/search?q=tileable+
desert+texture&newwindow=1&source=ln
ms&tbm=isch&sa=X&ved=0ahUKEwj-
9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB
&biw=1920&bih=940#imgrc=DSOUhXbeV5-
55M: 
 
And there are many others. 
 
The goal is to create a library of textures or 
patterns in multiple shades and two 
directions, so that texturing becomes just a 
quick and efficient choice of texture. 
 
The creation of patterns must be a well-
framed technique if we wish a minimum of 
flexibility to be able to modify them as it 
pleases. For roofs of buildings, you must be 
able to count on a dozen patterns, 
horizontal and vertical to different sizes. 
The same applies to walls, whether in the 
form of plaster of different colors, rubble, 
bricks or cladding made of metal or wood. 
Curtains and gates of industrial closures are 
also welcome. 
 
This collection is made as and when needed 
and is enriched with each new creation. 
 
In order to change the shade, direction and 
size, here is how to proceed: 
- Load the seamless texture in the 2D 
software. 
- Lock and add a layer. 
- Save in 2D software format. 
 

At this point, you have not changed the size 
of your texture. 

 
To change color: 
- Fill the layer with a basic color. 
- Play with the transparency of the layer to obtain the desired effect. After several tries, by changing 
the basic color, you will achieve the desired result. 

Figure 104 - Collection de Motifs/Patterns Collection. 

http://www.museumtextures.com/
http://soundimage.org/
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
https://www.google.cz/search?q=tileable+desert+texture&newwindow=1&source=lnms&tbm=isch&sa=X&ved=0ahUKEwj-9NnxwMTZAhWCZFAKHVWjC9IQ_AUICigB&biw=1920&bih=940%23imgrc=DSOUhXbeV5-55M:
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- Save your work. 
- Export the texture in the desired format (preferably PNG). 
- Adapt the size (128x 128, 256 x 256, 512 x 512, 1024 x 1024 pixels or any other squared value). 
- Create the pattern. For most 2D software, this new pattern will be directly accessible for all new 
files, otherwise you must create and save a pattern library that will be loaded for each new file. 
 
It is also possible to add adjustments layers instead of just playing with color and transparency. 
 
To change the direction of the pattern, and change from a vertical to a horizontal orientation, 
starting from the last save: 
- Unlock the basic texture. 
- Create a copy on a new layer 
- Rotate 90 °. 

- Lock the basic texture and copy. 
- Save your file. 
Apply the end of the process: export, adjust the size and create a new pattern. 
 
For windows, doors, etc., you do not have to repeat the same drawing every time, you just have to 
create a standard layout of all the basic elements of a building's facade. 
This path will be duplicated in each new file, then scaled appropriately and slightly retouched so that 
the vertices match with the pixels. 
The elements of this layout can then be duplicated as many times as necessary, to create the 
facades. Finally, the application of colors or textures on the lines and backgrounds will give the 
desired view. 
 
the reference scale is fixed at 1 pixel for 5 cm and the heights standard is as follows: 
 
Height between floors: 3.0 m. 
Summit of doors, bay windows, and windows: 2.30 m. 

Figure 105 - Création des Motifs à partir des Textures/Creating Patterns from Textures. 
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Heights under the windows: 0.90 m 
Double window width: 1.5 m. 
Door width: 1 m. 
Garage doors: 3.5 x 2.25 m. 
 
These are common standards in Europe. You have the choice to use your own measurements. 
All these individual elements must be closed rectangular path. 

Figure 106 - Standard pour les Façades/Frontage Standard. 

 
Save this file as "MeasuresStd". 
The Basic Patterns and Paths have been created, they can be used for the texturing of HLn10, with 
the help of available photos. 
 
Transfer and scaling standard paths 
The windows of "HLn10" and "MeasuresStd" are then arranged vertically. By a simple L/G maintained 
on the path "Standard" and its moving to "HLn10" a copy of the path is made on "Hln10.psd". Return 
to the "HLn10" display and select all "Standard" Paths. Move them with the mouse on the lower left 
corner of the horizontal front face at the top, then Ctrl+T. While holding down the SHIFT key, adjust 
the scaling by moving the mouse with an L/G maintained from the top right corner. 
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Then you have to adapt the paths so that they correspond to an exact number of pixels. 
 
Let's go back to the basic texturing by creating or choosing the appropriate textures for the walls and 

roof of the hangar. 
Then you have to create the wood 
cladding around the hangar and adjust 
it so that it is similar to the photos. 
To do this, you have to go back and 
forth between the 2D drawing and 
AeroLienz in Wings 3D until the 
claddings are correctly aligned at the 
corners of the building. 
Save HLn10 as PNG to the "Textures" 
folder by replacing the original Texture 
Map. Then in the window "Outliner" of 

Wings 3D: R/D on Hln10 in the folder 
"Image" -> L/G on "Refresh". The new 

texture is applied on the HLn10 hangar in Wings 3D. 
 
Then we must create the gate of the hangar, arrange the 
doors and windows on each facade with the help of 
photos. With standard paths created and scaled this is 
done quickly. 

Figure 107 - Mise à l'échelle des Tracés Standards/Standard Paths Scaling.  

Figure 108 - HLn10: Textures de base/Basic Textures. 

Figure 109 - 1er Essai avec les bardages en bois/1st 
test with wooden cladding. 
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By copying and pasting, the standard 
paths are duplicated in a new path to 
create the building's gates, windows 
and doors. Some adaptations are 
obviously necessary. 
 
 
 
 
 
 
 
 
 
 

 
It only remains to apply the same processes to the other 16 buildings of Lienz-Nikolsdorf, to 
complete the modeling of the airport with Wings 3D. Lock everything and save your work! 

6/ Wavefront Export(.obj). 

Wavefront is a generic, standard file format that describes a 3D object in a simple, open form. 
"Wavefront" files, with the ending ".obj" and the file ".mtl", can be opened with Notepad because 
they are ASCII files. Many 3D modelers can export their 3D object files in this format and vice versa, 
using the "Export" and "Import" commands. In this case, Wavefront serves as a relay between 
Wings 3D, Blender, 3DS max, etc., for conversion into C3D format. The C3D format is a proprietary 
format used by Condor to prevent third paries from copying or looting the objects used in the 
simulation. 

Export Options 

There are two "Wavefront Export Option" dialog boxes to be set. One, to export the whole scene, the 
other to export only the selected elements. 
Access to these dialogs is as follows: 
 
 

Figure 110 - HLn10 terminé dans Photoshop/HLn10 finished with 
Photoshop. 

Figure 111 - HLn10 Terminé dans Wings 3D/Hln10 Finished with Wings 3D. 
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"File -> Export -> 
Wavefront", 
and 
"File -> Export Selected -> 
Wavefront". 
 
The radio button 
"Triangulation" must be 
selected. 
 
Just click "OK" to make its 
options permanent. Then as 
nothing is ready simply 
cancel the choice of the 
name of the export file. This 
double setting will then 
allow you, if you create 
standard or scene objects, 
without any problem, 
depending on the type of 
export you want to do. 
Unfortunately, the two 
dialog boxes, although 
different for each type of 
export, have the same 
name. 

 
The setting must be in accordance with Figure 112, for both types of export. 

Make the Airport File Ready to Export 

After finishing the modeling and texturing of the objects of "AeroLienz" in a detailed manner, we will 
keep this file "AeroLienz", after having saved it, as a source of future modifications. To continue, we 
will make a copy with the name of the airport name registered in Landscape Editor. 
 
File -> Save As -> Access to the dialog box for giving a new name to "AeroLienz", i.e.: "Lienz-
Nikolsdorf" according to what has been registered for AA2 in Landscape Editor. 
 
The preparation will consist in grouping the different elements constituting the Airport runway under 

the 4 generic elements "Asphalt", "Grass", 
"Asphaltpaint" and "Grasspaint" in the window 
"Geometry Graph", and the cleaning of all 
unnecessary elements of the "Outliner" 
window. 
 
Create a "Piste" folder in "Geometry Graph". 
R/D on "GeometryGraph" -> L/G on "Create 
Folder" -> Name the folder "Piste" -> L/G on 
OK 

Figure 112 - Wavefront Export Options. 

Figure 113 - "Geometry Graph" après nettoyage/"Geometry 
Graph" after cleaning. 
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L/G on the folder Asphalt -> R/D on a padlock -> All objects of "Asphalt" folder are unlocked. 
Switch to Object Mode: O -> R/D on Cube icon -> All objects in the folder are selected. 
R/D in the window "Geometry" -> L/G on "Combine" -> Rename the only object remaining in 
"Asphalt" -> Select it with an L/G -> R/D on"Piste" folder - > L/G on "Move to Folder" 
The object "Asphalt" is transferred to the folder "Piste" -> L/G on the padlock of "Asphalt". 
 
Repeat this procedure with the "Grass" folder or transfer "Grass" into the "Piste" folder if you have 
used the Boolean method.  

 
In the same way, following the same process, the elements of the folder 
"Asphalpaint" will be combined into a single object renamed "Asphaltpaint" 
which will be transferred and locked in the folder "Piste". 
 
In the same way, following the same process, the elements of the folder 
"Grasspaint" will be combined into a single object renamed "Grasspaint" which 
will be transferred and locked in the folder "Piste". 
 
In Geometry Graph, eliminate all empty folders: 
R/D on the empty folder name -> L/G on "Delete Folder". 
 
Check "Geometry Graph" and save "Lienz-Nikolsdorf". 
 
In the "Outliner" window. 
and In the "Materials" folder 
Eliminate all elements of type Episte1 or Episte1_auv, Episte2 or 
Episte2_auv, etc., and the default materials Default1 to Default2, 
etc. 
R/D on the element to be eliminated -> L/G on "Delete". 
 
Check "Materials" in "Outliner" and save "Lienz-Nikolsdorf". 
 
In the "Images" folder 
Eliminate all unnecessary Images. Only non-material-related 

images can be eliminated. and a confirmation will be requested 
 
R/D on the image to be deleted -> L/G on "Delete" -> L/G on "Yes" on the confirmation 
request: "Are you sure you want to delete the image (NOT undoable)?". 
It is mainly the "EPiste .." Images that must be eliminated. 
 
Note that the "Grass" elements of "Materials" and "Images" could also have been 
eliminated, except that the green color of the grass set for the creation of this Guide 
would disappear in Wings 3D, which would be harmful for the good readability of this 
tutorial. 
 
However, as noted in the "Landscape Guide", the height and density of grasses in "Grass" and 
"Grasspaint" and cracks in "Asphalt" and "Asphaltpaint" are consecutive to the scale adopted in the 
respective UV Maps. To anticipate and preset this phenomenon which will probably require several 
tests, it is necessary to carry out a standard unfolding on all the elements of the folder "Piste". 
 

Figure 115 - "Images" 
après nettoyage/ 
"Images" after 
cleaning. 

Figure 114 - "Material" 
après 
nettoyage/"Materials" 
after cleaning. 
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Successively, for each object of the folder "Piste": 
Unlock Element -> Switch to Object Mode 
-> R/D in the "Geometry" window -> L/G 
to "UV mapping" -> R/D in "AutoUV 
Segmenting" -> L/G to "Segment by "-> 
L/G on" Projection "-> New R/D in" 
AutoUV Segmenting "-> L/G on" Continue 
"-> L/G on"Projection Normal"-> The 
AutUV window appears -> R/D in the 
window Auto UV -> L/G "Scale" -> L/G 
"Uniform" -> Move the mouse to scale -> 
L/G to set the size. 
 
For a 630m runway, you must decrease 
the size to obtain a size according to 
Figure 114 for "Asphalt" before creating 
the Texture Map. Get the same scale for 
"Grass". On the other hand, for 
"Asphaltpaint" and "Grasspaint" the 
reduction of the scale must be much 
more important. 
Save Lienz-Nikolsdorf. 

 

Export 

We will create the two G and O files in "Wavefront" format, starting from the airport of "Lienz-
Nikolsdorf" Wings 3D file. 
 
Switch to Object Mode -> Select folder "Piste" -> R D on a padlock to unlock all folder objects -> R/D 
on the cube icon on the left to select the 4 elements of "Piste" -> L/G on "File" -> L/G on "Export 
Selected" -> L/G on "Wavefront" -> L/G on "OK" of "Wavefront Export Options" -> Add suffix G to file 
name Lienz-Nikolsdorf -> L/G on OK. 
 
Two files are created: "Lienz-NikolsdorfG.obj" and "Lienz-NikolsdorfG.mtl". 
 
Lock the 4 items in the "Piste" folder and save "Lienz-Nikolsdorf". 
 
Go to Object Mode -> Select the folder "Hangar" -> R/D on a padlock to unlock all folder objects -> 
R/D on the cube icon on the left to select all the elements of "Hangar" -> L/G on "File" -> L/G on 
"Export Selected" -> L/G on "Wavefront" -> L/G on "OK" of "Wavefront Export Options" -> Add suffix 
O to file name Lienz-Nikolsdorf -> L/G on OK. 
 
Two new files are created: "Lienz-NikolsdorfO.obj" and "Lienz-NikolsdorfO.mtl". 
 
Lock all the items in the "Hangar" folder and Save "Lienz-Nikolsdorf". 

Figure 116 - Mise à l'échelle approximative pour une piste de 620 m/ 
Approximative Scaled size for a runway length of 620 m. 
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7/ Transform G and O files into C3d files and link textures. 

Copy of the Textures of the buildings into the scenery. 

With Windows Explorer, open the folder "Airports" or "Airports/Textures" of the AA2 scenery, in this 
case. 
It is a particular choice to group all airport textures in a "Textures" folder, and in sub-folders 
dedicated to each airport. As there are so many airports in AA2, this is the best choice, and the more 
versatile. 
Create a folder named "Lienz" to regroup all the textures of Lienz-Nikolsdorf. 
 
Go to the "Textures" folder of the airport where you have grouped all the textures of the buildings. 
 
Select all PNG files and copy these files into "Condor2/Landscapes/AA2/Airports/Textures/Lienz". 
 
In this case, the only thing missing is the texture of the windsock mast, named "Pole" which is 
common to several airports and it must be put in the folder "Com". 

Creating Lienz-Nikolsdorf C3D G and O Files,  

Creating"Lienz-NikolsdorfG" C3D File" 

 
Open Object Editor. 
 
Open the file "Lienz-NikoldorfG.obj" located in the working folder of Lienz. 
 
Here is what we get: see the following figure. 

Figure 117- Lienz-NikosldorfG Brut/Raw. 
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We must eliminate the 4 textures: LL/GG on the first texture -> "Delete" key. 
Repeat for the other 3 textures. 
 
Then after removing the textures you get this: 

Figure 118 - Lienz-NikolsdorfG. 

It only remains to save in C3D 
 
"File -> Save to C3D" in the working folder then in the "Airports" folder of the scenery, having to 
rename the old files Lienz-NikolsdorfG and O by adding the suffix "old", not to lose them in case of 
any issue. 
 
Check your work by loading the newly created C3D file into the "Airports" folder of the scene. 
You should not get any differentiation of runway elements except to switch to Wireframe mode by: 
"Tools -> Wireframe". 
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Figure 119 - Lienz-NikolsdorfG.c3d de "Airports", en mode fil de fer/wire frame. 

 
You will note that the triangulation, during the process of generating the "Wavefront" files, add most 
of the edges that had been eliminated at the end of the process of creating "Grass" by the Boolean 
method. It is difficult to do without this elimination of edges except for very simple cases. 

Creating "Lienz-NikolsdorfO" C3D File 

Open Object Editor. 
 
Open the file "Lienz-NikolsdorfO.obj" located in the working folder of Lienz. 
 
Here is what we get: 
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Figure 120 - Lienz-NikolsdorfO.obj, Brut/Raw 

 
This is normal because the textures are not linked and an existing texture is not listed. 
 
First set to value 1.00 except for the 3 Windsock "Windsacks1 to 3" the following parameters of each 
texture: 
"Spec" (Specular), "Shiny", "Red", "Green", "Blue", and "Alpha" (Transparency). 
And keep at 0.00 "Env" (Ambient). These standard values are not really imperative and you can learn, 
by successive tests, to use them to improve the appearance of your textures. 

Then write the names of the missing textures in this case 
HLn04.png. 
Finally, you must enter the path to the textures: You must 
use the tool "Replace texture path" accessible by: "Tools -> 
Replace textures' path", then complete the "With" by 
"Landscapes/AA2/Airports/Textures/Lienz/". 
 
Do not forget the last slash "/", and L/G on OK. 
 
Then as the "Pole" object is common to several airports it 
is necessary replace "Lienz" by "Com" in the path to the 
"Pole.png" texture. 
 

The path to the textures can be relative, which will avoid repetitions and make changing of scenery 
easier. 
In what follows: "Landscapes/AA2/Airports/" can be deleted for airport textures. 
 
Here is the result of editing the options for each object in the O file: 
 

Figure 121 - Fenêtre d'édition des chemins de 
textures/Replace texture path window. 
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Figure 122 - Finalisation des options des objets du fichier O/Finishing the objects options for O file. 

 
It only remains to save in C3D and check that all the objects are correctly textured in the file "Lienz-
NikolsdorfO.c3d" of the Airports folder of AA2. 
 
If no error has been made in airport creating, here is the result obtained with all objects "hangar", 
correctly textured, in opening the O file of "Airports" folder in AA2: 

Figure 123 - Lienz-NikolsdorfO.c3d du répertoire "Airports" de AA2. 
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8/ Airport Integration in the scenery with Landscape Editor 

Close all the software, and save if necessary. It is time to start Condor 2, and to create a task from 
Lienz-Nikolsdorf, with zero thermal activity and no wind and try to make a first flight from this new 
airport, whose departure will be towed, or winched or in flight. 
 

Figure 124 - Vue générale de Lienz-Nikolsdorf dans Condor 2/General View. 

The first flight around Lienz-Nikolsdorf shows that there is little alteration to altimetry and position. 
No wonder, because Lienz-Nikolsdorf existed as a standard airfield in AA2 0.5. 
Although the integration of the airport is always done by the designer of the scenery, here is the 
tests chart to be carried out. Some of them can be carried out by Condor's volunteers. 
 
However, before carrying out these tests, you must take screenshots of the height map in Landscape 
Editor and at the zoom factor of 10.67, covering the airport area. 
 
The purpose of this chapter is to definitively determine the position, the direction and the altitude of 
the airport, starting from the data registered in Landscape Editor at the time of the creation, and 
which generally relate to the ICAO data or to standard runway size of 400 x 25 m. 
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Figure 125 - Lienz-Nikolsdorf dans Landscape Editor - Zoom 10.67 -> Toutes les élévations sont visibles au pas de30 m. 

Airport Loading Test at 25-24 km 

This is an important test that could have consequences for the final viability of the airport, because 
the only parameter, which can be changed without simplifying part of the geometry of the buildings 
of the airport or eliminating a part of "Asphaltpaint", or "Grasspaint" it is the decrease of the size of 
the textures of the buildings which composes it. 
 
In Condor 2, create a task from an airport located more than 28 km faraway that ends on Lienz-
Nikolsdorf, departure in flight 1500 m, all available options and more particularly "Allow height 
recovery". Approaching 26 km slow down and monitor the FPS, also watch the appearance of the 
triangle men at work. Around 24 km, you should at least see a drop in FPS. 
 
For this first test for Lienz-Nikolsdorf, the results are very good in free flight, the FPS are around 320 
and we go down to 315 when loading files from the airport. There is therefore a significant margin to 
check as the complexity of the scene increases. A test was conducted in multiplayer with 44 players. 
The FPS indicated are then 103. Again, the margin is important for a minimum of 60 with a GTX 750 
TI graphics card. 
 
Indeed in this area there is no forest area defined with the Forest Map nor Water Alpha that doubles 
the weight of the tiles from 2731 kb to 5432 kb, nor other objects around or in the definition of the 
airport. 
 
With each significant increase in the complexity of the scenery or the airport, it will be necessary to 
repeat this test to ensure that the FPS do not go below 60 in multiplayer flight and that the loading 
time does not exceed two tenths second. In the worst case, if you exceed a loading time of more 
than 2 seconds a blue screen may appear, it has already occurred on Condor 1 and Condor 2 scenery! 
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Basic Take-off Tests 

Without having made any flattening of the airport zone, it is necessary to try although it is sometimes 
very chaotic, if not impossible, to take-off in both directions, to know if there exists or not difficulties 
of towing, mainly for the airports located in mountains. 
 
Indeed, it is necessary to fix the orientation of the airport, and its position as quickly as possible. 
 
As we have already explained in the chapter on the tow plane ballet, you can change several 
parameters in Landscape Editor so that the take-off of the heavier glider towed by the less powerful 
tow plane could be done without difficulty. 
 
If modifications are necessary to make towing possible, consider them in this order by modifying the 
corresponding parameters in Landscape Editor: 
- the length of the runway, 
- the position of the runway, 
- the altitude of the runway. 
- the orientation of the runway, 
 
But this will each time affect the appearance of the scene and increase the work to be done. 
 
However, it is preferable as indicated below to optimize before the start of the towed take-off tests, 
the length of the airport in Landscape Editor, to avoid having to repeat the tests, except if you 
already use standard runway size of 400 x 25 m. 

Airport Direction and Postion. 

This is to begin the integration of the airport into the scenery once the first preliminary tests have 
been completed. 
 
Open Landscape Editor and load the scenery, and check the box "Airports" and "Height Map". Find 
Lienz-Nikolsdorf, then R/D on this airport. The coordinates of the center of the runway are 
Latitude=46.798199, and Longitude=12.878100. 
 
The final position will be given by the creator of the scenery, but here are the key figures, deduced 
from the use of a UTM /WGS 84 converter, allowing a fast correction for a latitude of 46 ° on the 
reference meridian of 9 ° for the UTM 32N zone. 
A pixel on the tile, or patch, in the standard format of Condor 2 represents 2.8125 m, that is 
a variation of Latitude of 0.0000253 ° and Longitude of 0.0000363 °. 
 
The same calculation from the coordinates of the airport of Lienz-Nikolsdorf gives a variation of 
0.0000239 ° for the Latitude and 0.0000383 ° for the Longitude for a gap North/South or West/East 
of 1 pixel. 
 
Normally, the moving and rotations to position and orient the airport, are made only in Landscape 
Editor, with the help of the textures of the scenery and the display of the zoom elevations to 10.67, 
so that the 30 m grid is displayed . And 30 meters are 11 pixels. The correct setting is therefore easy 
to evaluate, and in 3 iterations the positioning must be perfect. As for the orientation, we must 
choose the best compromise to 1 degree. Do not forget to save your successive settings with "File -> 
Save Landscape". Be careful with the loss of compatibility when you change the file "Apt" or 
"Heightmap", don't forget the HTA files against cheating. 
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For AA2, where the textures cannot be displayed, it is necessary to proceed in a slightly different 
way, it is a little bit longer. 
While keeping Landscape Editor open at 10.67 zoom on Lienz-Nikolsdorf, you have to open Condor 2, 
and create a task from Lienz-Nikolsdorf with an airborne flight start at 1500 m. F2 to have an outside 
view of the glider. Position yourself above and away from the glider and zoom out to minimize the 

size of the glider and take a 
picture. 
View the photo, first optimize 
the orientation by changing 
the value in Landscape Editor 
until you get a correct value. 
Repeat the flight in Condor 2, 
and take a picture in the same 
position. 
 
Open the photo in Photoshop, 
or your favorite 2D software. 
Draw the axis of the runway. 
Position this axis on a 
remarkable point, in this case 
the center of the circle where 
the windsock is. This circle is 
exactly 15 m in diameter. 
Make a copy of the axis. 
Rotate an axis by: -121 ° (+ 
121 ° is the value chosen for 
the orientation of the runway 
in Landscape Editor). Rotate 
the second axis: - (121 ° -90 °), 

that is -31 °. The two axes are then oriented North-South and East-West. 
 
Zoom in to enlarge the circle. Reposition 
possibly the axes. Deduce the correction to 
make. 
 
It is necessary to decrease the Latitude of: 
2.24 x 0.0000239 = 0.0000535 ° 
 
and increase the Longitude of: 
2.0 x 0.0000383 = 0.0000766 ° 
 
Once the corrections have been made, you 
have to check the entire airport area for the 
right compromise, by a new flight in the 
scene, because some rounding in the value 
is made by Landscape Editor. 
Otherwise, you have to recalculate the 
settings. 
 
The best compromise should be found in 3 
iterations, because besides the rounding on 

Figure 126 - Réglage de la position de Lienz-Nikolsdorf/Adjusting the position of 
Lienz-Nikolsdorf. 

Figure 127 - Estimation des corrections/Estimated corrections. 
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the calculated values, there are always small errors in the modeling. 

Altimetry adjustment 

The altimetry adjustment assumes to choose a value adapted to the take-off of the heaviest glider 
for as many tow planes as possible. However, at this step of the integration of the airport, no tow 
plane has been validated as being used safely and with no restrictions. 
 
In addition, the artificial intelligence that takes control of the tow plane as soon as it reaches 100 m 
AGL follows two successive, precise goals. The first is to get you as directly as possible on the starting 
gate, then once this TP is reached to take you under the nearest windward cumulus. This is standard 
practice in the plain for beginner pilots, who, if they cannot find a lift, are brought back by the wind 
to the starting TP which is very often close to the airport. But this process is not very well suited to 
airports in mountainous areas. This point will need to be integrated into the qualification process by 
creating test tasks with starting TP on the mountain, closest to the runway, to ensure that the tow 
plane is not too close to the mountain wall when reaches 100 m AGL and that avoidance is normally 
done by Artificial Intelligence. 

 
Normally, the setting adopted for orientation based on OSM data or photo-satellites, projected in 
UTM is the correct setting, as the orientation given at the airport is a result of the real-life 
experimentation. 
 
For a first choice of altimetry, we have 4 primary options: 

Figure 128 - Premiers aplanissements/First flattening. 
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- Use the official altitude listed by ICAO and that should be the one entered in the properties of the 
airport in Landscape Editor. 
- Use the average, between the highest point and the lowest point of the runway in Landscape 
Editor. 
- Choose the altimetry from the starting point of the glider 200 m from the end of the runway in 
Landscape Editor. 
- Use the highest point of the runway. 
 
All of these options have their advantages and disadvantages. The choice of altimetry from the 
departure of the glider is the least destructive for the surrounding altimetry for a first flattening 
limited to the take-off of the glider and possibly to the parking of the tow plane. 
 
Diagrams 13 and 14 with their result tables in the first part of the Guide will help you decide the 
altitude of the first limited flattening. 
 
The surface concerned by the first flattening deduced from the take-off chart, if we do not take into 
account the Piper Super Cub, is of the order of 270 x 60 m around the axis of the runway starting 
from the departure of the glider, and its reciprocal in the other direction of the take-off (figure 128). 
 
The purpose of this first flattening is to have a sufficient length to take off the Duo Discus at full load 
(750 kg) with most tow planes. 

Method for Flattening Surfaces in Landscape Editor 

- Open Landscape Editor. 
- Check "HeightMap". 
- With the "Hand" tool, move the map to the desired location. 
- If it is to flatten an airport, check "Airports", and the 3 boxes at the bottom, "Draw Name", "Draw 
Surfaces", "Draw objects" (Draw the buildings from the O file). By an L/G on the name of the airport 
in the airport display window, it is highlighted. So it's drawn in a red wire frame in Landscape Editor. 
Note that this is always the same drawing of the G and O files that you will get in Object Editor with 
the "Wireframe" option. 
- Zoom to zoom factor 10.67, so that the original 30m mesh is displayed. In Lansdcape Editor, the 
altimetry in meters is displayed on or near the vertex at the intersection of the vertical and horizontal 
mesh grid. With the "Hand" tool selected, an L/G on the map increases the zoom factor, and an R/D 
decreases it. 
- As a precaution, take screenshots to cover the area to modify keeping the zoom factor of 10.67. 
- Highlight "Height map" with L/G. The flattening tool appears. L/G on the "Flatten" button shows the 
3 available options: 

- "Radius": Set the radius of the circle around the cross-wires by the slider between 1 and 100 
points. At a zoom of 10.67, adopt 30 points to change each altitude vertex of the mesh 
individually. 

- "Altitude": Value in meters of the final altitude of the flattening. 
- "Edge slope": adjustment of the altitudes between the final altitude and the initial 

topography. Six settings are available: 1: 0, 1: 1, 1: 2, 1: 3, 1: 4, 1: 5. With 1: 0 there is no 
adaptation and as we move to a stronger setting, the radius of the second circle surrounding 
the first circle around the cross-hair increases. The software averages the altitudes between 
the circle around the cross-wires and the outer circle. Adopt 1: 0 when you begin to flatten 
the ground. It will always be time after visualization in the simulation to use this form of 
integration into the landscape by softening slopes. 

 
- Set your tool on the altitude you want to get. 
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- Use of the "Flatten" tool: as soon as you are on the map, the cross-hairs and the two circles appear. 
An L/G maintained allows to modify the altimetry during the displacement of the mouse. All the 
vertices of the mesh within the first circle which are overflown by the tool are modified and adopt 
the set altitude and all the vertices between the two circles are adapted to soften the slope with the 
surrounding topography. 

Figure 129 - L'outil "Flatten"/"Flatten" Tool. 

- Once the altitude changes have been made, Landscape Editor displays the new values, but the 
"Heightmap" file is still not modified. 
There is still time to discard the changes if you exit Landscape Editor without saving the scenery. 
Altitude changes may make the multiplayer flight incompatible, if the new settings are not adopted 
by the other flight players and the server. 
- To make the final altitude changes here is how to proceed: 
"File -> Save Landscape", and L/G on "OK" in the "Info: Landscape saved" dialog box. 
But we must also update the "THA" anti cheat file by: 
File -> Export hash field (THA) "then, L/G on" OK "in the" Info: THA exported "dialog box, at the end 
of the process when the progress bar closes, if necessary, adjust the altitude of the airport in the 
airport Landscape Editor properties, to that chosen for flattening and save the scenery again. 

Tow plane validation tests  

Contrary to what has already been written, all tow planes must be used in validation tests. 
 
The purpose of these tests is to provide a precise NOTAM "Notes To AirMen" for each airport, so that 
task planners can create reliable tasks starting from the airport. 
 
In the lowlands, there are very few problems in qualifying all tow planes. 
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In the mountains from the statistical point of view after the adaptation of the airport we obtain the 
following results: 
Wilga: 100% 
Zlin: 90% 
DR400: 70% 
For other tow planes, the results are variable and sometimes random. It's even easier for an alpine 
airport to qualify the Super Cub than the DR400. 
 
The minimum area covering the two interlaced 270 x 60 m sectors being flattened at the chosen 
altitude and recorded in Landscape Editor, open Condor 2 and create a departure from the airport 
with a starting TP in the nearest mountain of the runway, to test a fair reaction of the artificial 
intelligence after the 100 m AGL altitude. The weather setting is: zero wind, zero thermal activity, all 
other settings on "None" or "weak". Low inversion below cumulus formation. All parameters for the 
wave are set to zero. 
Choosing the glider with the highest, "Max weight", the Duo Discus at 750 kg with full ballasts and 
the second pilot. Notam with all the boxes checked, and towing to 700 m with a 50 m long rope. 
Save this flight plan, under an appropriate name. 
L/G on"Start flight" on Condor 2. 
Normally, you must be at the beginning of the flattened portion of the runway with a tow plane at 
quite the same altitude. 
Start the flight. The tow plane moves horizontally from the altitude of its parking spot. Check that the 
tow plane is at the same altitude as the runway. Normally the glider must have become airborne in 
the flattened area. Do not raise the landing gear. Do not worry if the tow plane sinks into or over the 
runway. After take-off, the tow plane will emerge at one time or another, or you will reach its 
altitude at one time or another in the air. 
Then, if the tow plane in flight sinks again into the mountain before reaching the 100 m AGL and no 
avoidance maneuver prevents the glider from crashing, you only have to change of tow plane and 
observe what happens with each new tow plane until the Wilga is selected. 
 
In this case, observe with more attention, what happens, if the tow plane reaches the 100 m AGL, or 
if it remains in a similar situation of failure. 
 
If the Wilga doesn't reach the 100 m AGL goal, you have to analyze the situation with the previous 
results to find the least penalizing solution, which, in fact, is very often the lengthening of the runway 
in Landscape Editor. Indeed, if you extend the runway by 200 m the departure of the glider will go 
back 100 m, but the touchdown of the tow plane when landing moves back 100 m and so does the 
storage area for gliders waiting on the runway in multiplayer mode. 
The lengthening of the length of the runway in Landscape Editor can easily be increased until 400 m. 
In this case, the departure of the glider is on the threshold of the runway of G file, or farther if there 
are extensions of the runway. More radically, if the difficulty concerns only one direction of the take-
off, it is necessary to shift the center of the scene in Wings 3D, while remaining on the axis of the 
runway. This will require redoing the G and O files of the airport. For other possibilities, do not 
exceed 30 m in lateral offset, 20 m in altitude, and 3 ° in runway orientation. All these modifications 
will definitely require you to complete the basic flattening. Once the obstacle of 100 m AGL passed, it 
is necessary to continue to know if the answer of the artificial intelligence is correct, and to apply 
possibly the same recipes as previously to pass this second obstacle of the qualification. 
 
For take-off tests in the opposite direction of the runway, avoid setting wind and change the 
"Primary dir Reversed" option in Landscape Editor instead. Correct until you get the qualification of 
one tow plane, possibly applying the same recipes for both directions of the runway. 
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An equivalent test exists by adding a crosswind of 20 km/h towards the nearest mountain wall, as the 
tow plane drifts with the wind, but its rise is accelerated by slope ascents. Both tests proposed with 
or without crosswinds are valid. 
 
Even if these test chart, that has just been drawn up, may seem complex, a solution for one or more 
tow planes will be found quickly if we follow the logical order of how to correct the difficulties 
encountered. In more than 80% of cases, there will be nothing to change to qualify at least two tow 
planes. 
 
For Lienz-Nikolsdorf no changes were made to the initial settings to qualify all tow planes at the 
reference altitude of 640 m. 

Optimizing the length of the runway in Landscape Editor 

If, as with Lienz-Nikolsdorf, all tow planes are qualified, consider very seriously reducing the length of 
the runway in Landscape Editor, as the glider storage area must be taken into account in multiplayer 
flights. In addition, and for any other airport, to avoid redoing the take-off tests it is better to start 
from this optimized value, even if it is extended later in case of difficulties. 
 
The weakest flattening surfaces along the runway axis are obtained with a 400 m long runway in 
Landscape Editor. In this case, regardless of the direction of the take-off, the starting glider is in the 
center of the runway, and it will have all the glider storage area planned for take-off in the other 
direction in front of it. 
 
The evaluation of the storage area can be done in the following manner, for a "joint time" 
(multiplayer flight access time) of 10 minutes. A take-off is initiated every 30/35 seconds, but this 
duration is variable. It can exceed the minute for tow planes far from departure. In 10 minutes, 20 
gliders can be airborne, and there remains 44 to take-off which must be stored on the ground at the 
time of the closure of the "Joint Time". Knowing that the gliders occupy 10 linear meters in the 
storage queue, it takes at least 440 m of storage area. 
 
For a "joint time" of 15 minutes, 30 gliders will have taken off and the remaining 34 gliders will have 
to be stored on 340 m. For a "joint time" of 20 minutes 40 gliders will have taken off and the 
remaining 24 gliders will occupy a line of storage of 240 m. 
 
As there may be times during which the take-off queue is empty, and there are not always 64 gliders 
in each multiplayer flight, it seems reasonable to adopt a storage area of 360 m (12 x 30 m for 
flattening), with a 15-minute "joint time" for daily flights and 20 minutes in competition, or flatten 
out 720 m in the center of the runway over a minimum width of 60 m (2 x 30 m). 
 
Referring to the experiments in figure 13, on the 360 m the heaviest glider will have taken off with all 
tow planes except the Super Cub. But only the Wilga can take off at this distance. 
 
So for the shortest runways in the mountains a possible choice is to set the length of the runway at 
400 m with a minimum flattening of 720 m (2 x 360 m) for glider storage. If this is not possible, it will 
be necessary to indicate the corresponding restrictions in the Notam. 
 
But even with a short runway, if you can extend the flattening in the axis of the runway without too 
much deforming the surrounding topography it is interesting to increase the length of the runway in 
Landscape Editor. 
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On the other hand, if the runway drawn with the G file is long, it is in the best interest to confine the 
flattening in this space, if, of course, it does not reduce the number of qualified tow planes. 
 
Or, if the runway has a particularity that requires the departure of the glider on a concrete surface, 
you must adapt the length of the runway so that the departure is done at this right place. 
 
In a very general way, here are the simple linear equations which govern the parameters of a 
runway: 
knowing that the glider is initially 200 m from the runway threshold (400 = 2 * 200 in the equations 
below). 
 
O, center of the runway. 
S, departure glider parking point 200 m from the runway threshold. 
 
L, length of the runway in Landscape Editor. 
Z, length of glider storage areas. 
H, runway length in front of the glider: H = L-200 
U, total length to be flattened: U = L + 2 * Z - 400 
F, flattened length in front of the glider at take-off: F = L + Z - 400 
 
 
Which corresponds to the following diagram.

 
Figure 130 - Schéma pour l'optimisation de la longueur de piste/Diagram for optimization of the runway length. 

 
And in the following result table for a storage length of gliders of 360 m. 

L 0 100 200 300 400 500 600 700 800 900 1000 

Z 360 360 360 360 360 360 360 360 360 360 360 

H -20 80 180 280 380 480 580 680 780 880 980 

U 320 420 520 620 720 820 920 1020 1120 1220 1320 

F -40 60 160 260 360 460 560 660 760 860 960 

All values are in meters. 
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To compare with the table of the first experiment:  
 

Remorqueur/Tow-
Plane OA OB OC 

DR400 190 390 1600 

Dynamic 260 450 1690 

Super Cub 370 670 2000 

Wilga 150 330 1450 

Z226 250 390 1500 

 
From these data, it is then easy to determine what optimal value to give for the length L of the 
runway in Landscape Editor. 
 
For Lienz-Nikolsdorf, in order to minimize the areas to be flattened, it would suffice to calculate L 
with U equal to the drawing of the hard runway in file G, i.e. 630 m. 
630 = L + 720-400 -> L = 630 - 720 + 400 = 310 m. This value is a bit low, and to ensure that the Super 
Cub takes off before the end of the runway, it takes a value of L of 700 m. The initial choice of 660 m  

Figure 131 - Aplanissement à réaliser/Flattening to make. 
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is therefore validated, it is then sufficient to ensure that the length of the flattening U is greater than 
or equal to 980 m by applying the formula. If, on the side of the NW runway, there are no problems, 
it will be necessary to lengthen the flattening on the SE side by about a hundred meters, according to 
the diagram (figure 131). 

Finalization of the Airport 

Final flattening 

At this stage of the development of the airport, the position, direction and altitude of the airport are 
permanently fixed and there is at least one qualified tow plane. 
 
It is time to flatten the ground at the fixed altitude over the entire airport area, that is to say the area 
delimited by the G and O files and the storage areas of the gliders if they leave the previous area. 
 
Be aware that any point in the 30 m altimetry grid must belong to the 4 squares of 30 m surrounding 
it. If one of these squares contains a portion of the airport zone in red when the airport is selected in 
Landscape Editor, the point of this mesh must be set at the altitude of the airport. To prevent grid 
vertices from being forgotten, always work with a zoom of 10.67. 
 
Once this flattening is done, it is necessary to check in a static flight on the ground in Condor 2 and 
still using the key F2 and by using the zoom that all the ends of the airport are at the right altitude 
and that each corner of the buildings is currently on the ground. For very large airports, because the 
grid at 90 m is underlying, it will probably be necessary to extend the flattening to squares on the 
logic of 90 m instead of 30 m to be certain that the distant buildings are on the ground, and that the 
concrete runway has no side or end defects. Its anomalies are noted at the ground level by visual 
artifacts, such as the momentary disappearance of the runway or grass, or the impression of a 
floating building seen from a particular angle, while in Landscape Editor, the altitude required is well 
fixed at the correct altitude. 
 
This requires great attention and must be finalized by a rolling test for the complete runway and the 
storage area if it overflows. 
 
To perform this rolling test, launch the towing, open the air brakes and brakes excessively so that the 
tow plane does not reach its take-off speed, to cover the entire runway and the glider storage space. 
If your attention is attracted to an artifact during this test, drop the tow plane, stop on the runway 
and go into an external view and examine the area carefully to find out where you need to level or 
widen the flattening. 
 
Repeat the taxi test to validate the untested part of the runway and the glider storage area, as many 
times as there are interruptions due to artifact discovery. 
 
Repeat these rolling tests in the other direction of the take-off to validate the end of the runway and 
the storage area not yet controlled. 

Define the last parameter of the runway 

Some properties of the airport must be definitely fixed in Landscape Editor. These are the 4 
parameters fixing the rolling of the tow-plane on the airport area: the width of the runway and the 3 
checkboxes. 
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Start by choosing the axis of the windless runway based on the results of the tow planes validation. 
 
For the other parameters, only experimentation will give you an adequate answer: 
 
Use a task starting from Lienz-Nikolsdorf. Launch the flight and drop the tow plane by R. then F5 to 
follow the tow plane in its evolution. Care must be taken at the end of the tow plane flight when the 
tow plane is landing and then determine which are the best choices for the width of the runway and 
the tow plane's parking to the right or left of the glider. 
 
Don't forget to save the scenery in Landscape Editor. 

Control of cracks on "Asphalt" and "Asphaltpaint" and the size of grass tufts on "Grass" and 

"Grasspaint" 

When the G file was created, a UV map and a first reduction of the map were made on the 4 basic 
textures. Now, the question is whether they are suitable for the current modeling. Only a static flight 
in Condor 2 will allow you to get a real idea of what to do. A priori, one would increase all sizes of 
each texture, i.e. decrease the scale in the UV Map. 
Open Wings3D, and load the Lienz-Nikolsdorf file. In "Geometry Graph" L/G on "Piste" where the 4 
objects, "Asphalt", "Asphaltpaint ", "Grass"and "Grasspaint " can be found. 
Unlock a first object and select it in Object mode. 
Then through the Menu: "L/G on Window -> L/G on UV Editor". The UV map of the object is 
displayed in the AutoUV window. "R/D in the AutoUV window -> L/G on Scale -> L/G on Scale 
Uniform". Move the mouse and decrease the scale by about 60%. R/D in the AutoUV -> L/G window 
on "Create Texture" -> L/G OK of the "Draw Options" window if nothing has been changed. Close the 
window, lock the object. 
Repeat 3 times for the 3 other items. Save the file Lienz-Nikolsdorf. 
 
Next, unlock the 4 items of the "Piste" folder, select them in Object mode, and "File -> Export 
selected -> Wavefront, etc. Recreate a file Lienz-NikolsdorfG.c3d.Then make a static flight in order to 
check your work. Grass tufts of "Grass" are thicker, "Asphalt" is perfect, the cracks on "Asphalpaint" 
are maybe a bit too big. Grasspaint is obviously thicker. 
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Figure 132 - "Asphalt" & "Asphaltpaint" corrigés/corrected. 

 
Figure 133 - "Grass" & "Grasspaint" corrigés/corrected. 

After a first correction, if you feel that one or more elements of the "Piste" are not yet correct, it is 
sufficient for the elements concerned to change the scale of the texture map again, and to redo a G 
file, as indicated above. This will take only a few minutes. 

The Underlayment of the Airport 

Inevitably, given the resolution of 2.815 m/pixel of the tile t4570, there will be blurred around 
"Asphalt", discrepancies between the silhouette of the airport on the patch, and "Asphalt", because 
the orientation airport in Condor has a 1 ° precision not to mention the errors that we produce by 
the very fact of modeling. There are even sometimes undesirable prints on the patch like planes on 
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the parking place. Or even for Lienz-Nikolsdorf works around the runway being repaired that have 
disappeared. All these elements must be erased. In addition, the "Grass" element is no longer visible 
as soon as you gain altitude. It is therefore necessary to make sure that there is an underlay under 
the airport area and its surroundings which definitely settle all these small defects. Similar problems 
are also observed with synthetic textures. 
 

 
Figure 134 - Lienz-Nikolsdorf avant transformation de la tuilette t4570/before changing the background of t4570 patch. 

 
Here is a technique, among many others, to remedy these small imperfections: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Version 1.0 en - 2019-09-16  Page 117/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

Figure 135 - Méthode de correction dans Photoshop/Photoshop correction Method. 

 
Make a copy of the patch first. Open the patch in Photoshop, where we will erase everything that 
seems useless. Create a layer on which we will apply the corrections. This is only an example because 
we did not move the airport to its required position and calculated in one of the previous chapters, 
for obvious server compatibility reasons. 
 
As we want to eliminate all unwanted spots on the airport area, we create a closed path that closely 
follows the contours of the zones corresponding to the "Asphalt", "Asphaltpaint" and "Grasspaint" of 
the airport and the parts that we wish to erase on grass. Then we create a pattern with a texture 
taken on the tile of a field near the airport and representative of the area we have just delimited. 
Finally, we apply this pattern to the path on the previously created layer. 
Save the file in PSD in the airport creation folder and in DDS in the Textures folder of AA2. 
 
A static control flight shows the result in Condor 2. 
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Figure 136 - Résultat de la transformation de la tuilette t4570/Result of the patch t4570 transformation. 

In ten minutes of work, we obtain a correct result. 

Forests and tree hedges and the WaterAlpha 

In this paragraph, we will remain more theoretical than practical, because the Master of Forests, 
Objects and WalterAlpa is the designer of the scenery. 
 
To make the level of integration of the airport in the scenery even better, it is necessary to create the 
forest zone, the hedges near the airport, and, if necessary, the lakes and even the rivers, and 
torrents. 
 
As the WaterAlpha works on the same format as Terragen tiles with 8192 x 8192 pixels standard, it is 
easy to draw 1 pixel wide torrents in black on a white background. In addition, it creates a superb 
silver effect in mountain thalwegs, when the glider is at a lower altitude than the torrent. 
However, these changes will increase the size of each patch from 2731 kb to 5472 kb, which will have 
an influence on the FPS. So a complementary test on the loading of the airport at 24 km must be 
carried out to validate these transformations. The modification of a Terragen tile with WaterAlpha is 
done in 5 minutes with the utility by Jiri Brozek, as explained on the forums of Condor. 
 
For tree hedges, which are objects that must remain as simple as possible, use only trees built on 
transparent dihedral. From these simple trees, to put in the "World" folder of the scene. You can use 
these objects in a unitary fashion, or even create linear mixed hedges as an object, or even create 
hedges, by moving the mouse pointer along the curve of the hedge with an L/G maintained directly 
in Landscape Editor. Normally, these types of objects that are loaded at 5 km should not change the 
FPS too much. 
 
Here is an example of what you can create as a dihedral tree in Wings 3D and in Object Editor. 
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As shown in Figure 137, the C3D files must have the suffix "_ns", so that the shadow of the dihedral is 
not projected in the simulation. The file name of this example is: "A_He1_ns.c3d". 
 
 
For forests, the context is more difficult to implement. In Landscape Editor you can currently, make 
corrections of the 2 "Forest maps" and save them. For reasons that are difficult to explain, we have 
encountered difficulties as to the durability of these modifications, as a result of a new modification. 
 
The corresponding forest patch around the airfield has disappeared and we end up with a square of 
5.76 x 5.76 km devoid of any forest. In addition, this type of correction for synthetic textures is not 
entirely satisfactory, because the underlying forests texture does not exist when forest trees are no 
longer loaded into the simulation. 
For all these reasons, it is better to work directly on the "Forest maps" tiles in 8192 x 8192 pixels 
format using a grid of 4 pixels, because this format will have to be reduced to 2048 x 2048 pixels to 
be transformed into a forest map. 
 
The grid with a pitch of 4 pixels makes it possible to precisely correct the map of the "forest map" so 
that it does not encroach on buildings, runways and taxiways of the airport. 
Moreover, for synthetic textures, it allows to harmonize the underlying texture of the forests with 
the other component of the scenery. 
 
Anyway, after the changing in the forest maps, it will be necessary to validate all of these 
modifications perform again tests of qualification of the tow planes and a test of loading of the 
airport at 24 km. 

9 / Improvements. 

We have finally created an airport with all the features that are at the level required for Condor 2. It 
is now a question of improving the aspect of this one to make it even more alive and more realistic if 
we wish. 

Figure 137 - Arbre-dièdre/Dihedral Tree 
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More Objects in "O" File or in "World" Folder 

At the beginning of this Guide, we have discussed the advantages and disadvantages of inserting 
complementary objects in the O file, or keeping them as unitary objects in the World folder of the 
scene. Our preference obviously goes for this last solution which seems more flexible and more 
versatile. These objects must have been created in a 3D modeler as ready-to-merge files in the 
modeler format, or available in Wavefront format with the object's ".obj" and ".mtl" files and 
accompanied by all their textures that you can easily import into the modeler. In this case you can 
always modify these objects to improve them and create multiple little new scenes and textures. 
Some objects are only available in C3d format with their textures and can only be used in the form of 
single objects in the World file of the scene. In this case you can only create new textures even if you 
do not have the UV Map. 
Note that you can always change the size in pixels and the format of the texture files of an object. 

More objects in O File 

In case you opt for this solution, for some or all new objects here is how to proceed: 
 
Open 3D Wings and load the airport Lienz-Nikolsdorf. Then merge these objects in Wings 3D, with 
their appropriate textures. Then you have to position them correctly by moving and rotating them 
(beware of Landscape Objects). In "Geometry graph", move the objects to the "Hangar" folder. 
Once everything seems correct, and after saving your work, you need to create a completely new O 
file following the process described above. Do not forget to transfer a copy of the textures of these 
objects in the "Airports/Textures/Lienz" folder of the scenery. A check flight is required to make sure 
everything is correct. 

How to use Landscape Editor to insert objects in Scenery 

Since the position, the direction and the altitude of the airport are fixed, the probability is low of 
having to move again the airport objects in the "World/Objects" folder. Anyway we can move them 
all together following a rectangular selection with the mouse in Landscape Editor. 
The object files are in the "c3d" format and are in the "World/Objects" folder and their textures in 
the "World/Textures" folder of the scenery. 
With Object Editor load the C3d file from each object in the folder and check, or create the path 
linking the object to these textures. 
Open Landscape Editor and load the Scenery. 
The objects are always placed on the ground, and when the ground is flat there will be no issue. But 
when the ground is steep, check that there is no part of the object floating in the air. If you find this 
kind of issue, you must add foundations, and use the suffix "-ns", for no shadow, to avoid artifacts on 
the built-in shadows during the flying simulation.Even for the satellite photo scenery it is always 
necessary to use "_ns" suffix. 
Check "Airports" and "Ground Objects". 
Highlight "Airport",and with the "Hand" tool move the map to the airport where you want to add 
objects (for example Reichenbach in WildAlps2). Highlight "Reichenbach" and check the 3 
checkboxes "Draw" at the bottom of the frame. Reichenbach is drawn in red wire-frame on the map. 
Then highlight "Ground objects". The "View" button does not work because Object Editor does this a 
lot better. In the drop-down list "Objects" you will find all the objects that have been placed in the 
"World" folder of the scene. 
Choose an object, for example the Grob103ID3PCO, a derived and completely restructured object 
from the Grob 103 available on the Condor2 website. L/G on the [.] Button and with an L/G insert the 
object at the desired location with the "cross-hair" cursor on the grass of the airport. Change the 
position with the "cross"tool, change the direction with the large"Dir" slider at the bottom. The size 
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can be changed with the large slider at the bottom. Scroll the mouse to adjust the angle to ± 1 ° when 
the slider is highlighted by a frame. The small "size" and "dir" cursors next to the button are used to 
insert the same object with a pre-defined orientation and size by successive L/G on the scenery. 
The other buttons are obvious to set up and use. 

Figure 138 - Insertion d'objets avec Landscape Editor/Inserting objects with Landscape Editor 

 

 
Figure 139 - L'objet Grob 103 dans Condor 2/Grob 103 object in Condor2 



Version 1.0 en - 2019-09-16  Page 122/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

When an object is not selected, it is displayed as a bounding black frame instead of the wire-frame 
silhouette. 
Save the scene with "File -> Save Landscape -> OK" and make a control flight. 
 
New loading tests at 24 km must be undertaken after modification of the O file, or after 
completing the airport with objects from the "World" folder. 

The magic word "Muck" 

If the texture of the standard runway with the "Asphalt" texture does not please you, or you seem 
too uniform, of a single color, without marks of deep cracks or repairs, or skid marks, if you want to 
change the color of some markings of the "Asphaltpaint", etc., the "Muck" is for you. And your 
creativity will no longer have limits with a little bit of imagination. 
 
You can create your own textures for the elements "Asphalt", "Asphapaint", "Grass" and 
"Grasspaint", but you have to replace the original textures, keeping the same names, by textures of 
your own in the "World/Object" folder of Condor 2. It works, but it deprives all the flexibility and 
versatility of "Muck". 
 
Other scenery designers have tried using Condor 1 techniques to specify textures locations for 
runway textures without using the "_muck" suffix and it did not work. Their textures have been 
ignored and replaced by standard textures. 
 
As on the forums of Condor, all those who used this Muck technique gave only short and partial 
information, we do some small experiments to frame the use of this excellent device. 
 
Condor 2 takes into account, with the suffix "_muck", all BMP, TGA, PNG and DDS textures formats. 
PNG and DDS formats are preferred. Regardless of the colors or textures change made, "Muck" keeps 
the cracks on "Asphalt" and "Asphalpaint" objects and grass tufts of "Grass" or "Grasspaint" object. 
 
The best solution, for different shades or textures of G file objects, is to create different scaled isles 
for each hue or texture during the UV Map.This will avoid any edge effect during the flight 
simulation. 
 
If you are led to change the size of one or more isles, for some elements "Aspahlt" or "Asphaltpaint", 
etc., or to cut them out on your UV Maps, you have to recreate the Texture Maps in Wings 3D and 
make external the new Textures Map, going back to "Internal" if necessary. You must also recreate a 
new G file. 
 
 
Once you have access to the new "Asphalt" and "Asphaltpaint", etc., textures in PNG or DDS, open 
them in Photoshop. 
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Figure 140 - Asphalt Texture. 

 
Then on the runway and on the apron and parking areas where we want to create differences you 
have to make paths and then paint or texture them in the colors you want on a layer or directly paint 
details with a brush on a separate layer. 
 
 

Figure 141 - Création des traces sur Asphalt/ Creating Marks on Asphalt. 



Version 1.0 en - 2019-09-16  Page 124/132 

Condor 2 Airports - Construction Guide  Xavier Delaborde © 2019 

To avoid unwanted black edge effects like those in Figure 142: 
 
We must add an intermediate underlayer color to give 
a background to our new texture whose parameters 
are: 
 
-A white underlayer renders exactly the original color 
of the "Asphalt" texture. 
-The darker the color of the underlay, the darker the 
"Asphalt" elements will become. 
Of course we can also put any color or texture to 
make sand or ash runways. 
 

This is what the finished texture for "Asphalt" should look like, keeping the initial hue for the runway. 
 

Figure 143 - Asphalt Texture Finale /Final Asphalt texture. 

That we save in PSD, then in PNG in the folder and under the name 
AA2/Airports/Textures/Lienz/Asphalt_muck.PNG. But any other name would be appropriate if the 
suffix "_muck" is present. 
 
Then, we operate exactly the same way for "Asphalpaint" after spotting the two strips of delimitation 
of the entry on the runway that we wish to paint in yellow. 
 
 
 
 
 
 

Figure 142 - Effets de bord/Side effects. 
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Figure 144 - Texture pour Asphaltpaint/Asphaltpaint Texture. 

 
This new texture will be saved in PSD, then in PNG in the folder and under the name: 
AA2/Airports/Textures/Lienz/Marques_muck.PNG. But any other name would be appropriate if the 
suffix "_muck" is present. 
 
With Object Editor, open the c3d file: "Lienz_NikolsdorfG.c3d" and add the name with their paths the 
new textures created for "Asphalt" and "Asphalpaint". 
 
Understand that you can do all what you want if you follow the above advice on all the ground 
elements of the G file. Why not flowers on Grass or blue stripes on Grasspaint or oil spot on 
"Asphaltpaint" element, etc.! 
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Figure 145 - Lienz-Nikolsdorf modifié/changed. 

Save the file in the "Airport" folder, but do not forget to manually add the suffix ".c3d" and then 
check that everything is correct by reloading "Lienz-NikolsdorfG.c3d" in Object editor. Not only must 
you see the hue changes of "Asphalt", but also the yellow stripes added on "Asphaltpaint". 
 
Here is the result on Condor 2: 

Figure 146 - Lienz-Nikolsdorf terminé/finished. 
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Figure 147 - Lienz-Nikolsdorf terminé/Finished 2. 

Lienz-Nikolsdorf is finished. 
 
Finally, here are some darker runways in the simulation: 
 

 
Figure 148 - Lienz-Nikolsdord avec des pistes plus sombres/with darker runways. 

 
In this booklet, we have covered all the main basic techniques for creating an airport in Condor 2. 
Your creativity and imagination, starting from these techniques, will allow you to go even further in 
improving the visual rendering of airports in Condor 2. 
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Annexes 

Notes to proofreaders, translators and readers 

This document has been designed from the beginning to facilitate its translation into all languages. 
The English version was written at quite the same time as the French version. However, only the 
French text is authentic. English is not our mother language, and errors could be left despite the care 
taken in translation and any corrections are welcome. 
All the explanations of the figures are bilingual, French /English, when translating to another 
language you must translate the French part and keep the English part. 
 
Many words are capitalized in the body of the text. We must keep these capital letters, because they 
correspond each time to an element of the airport, or to a software element that undergoes a 
transformation or a command of one of the software used. Otherwise, the word is usually lowercase 
unless typography or grammar requires it. 
 
All construction sequences are written with conventional abbreviations which must be respected, 
especially for clicks and movements of the mouse, L/G, R/D, etc., and the sign "->". The sequences 
use the notations (words, acronyms, abbreviations, etc.) of the English version of the software, 
except for few exceptions. It is therefore imperative to keep these sequences in English during the 
translation. Most of the time, they are enclosed in quotation marks. When they are encountered the 
first time or when they are considered to have been forgotten, a context-sensitive French translation 
is indicated in parentheses, following or below the sequence. This translation must be adapted in the 
language in which the document is translated, such as comments or additional information in French. 
To avoid confusion when translating, use in parallel the two versions, French and English, open 
simultaneously. 
 
In the chapter "Avertissement/Warning", only the French text must be kept, accompanied by the 
translation in the language where this guide will be translated. 
 
The names of the translators, proofreaders, etc. should be added at the bottom of the page under 
"Acknowledgments". 
 
If during reading or when translating this guide you find errors, anomalies, etc., please report them in 
the international forum. 
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